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ÚVOD 

S rozvojem techniky, cestovního ruchu, obchodu a celkově s uspěchaností doby se 
zvyšuje poptávka po leteckém provozu jakožto nejrychlejší možné přepravě do stále 
více lokalit. Tento trend s sebou bohužel přináší vyšší riziko nehod a incidentů. 
Pro zachování standardu bezpečnosti v civilním letectví je nutné dělat maximum. 
Na základě studie se v Evropské unii (EU) zrodila myšlenka vzniku jednotného 
evropského databázového systému hlášení leteckých nehod a incidentů, kde budou 
všechny informace ukládány, sdíleny a analyzovány. Vyhodnocení těchto analýz by 
mělo vést k odhalení případných hrozeb a následnému přijetí potřebných opatření 
k jejich nápravě. Evropská komise proto pověřila středisko J R C {Joint Research 
Centre of the European Commission) vytvořením systému ECCAIRS {European Co-
ordination Centre tor Aviation Incident Reporting System), sdíleného databázového 
systému, který byl zaveden pro členské státy EU a později se rozšířil 
i do mimoevropských států. 

Cílem této diplomové práce je definovat možnosti modifikací systému ECCAIRS 
pomocí sady nástrojů ECCAIRS 5 Taxonomy Design Tools, včetně návrhu konkrétní 
modifikace pro zefektivnění práce s tímto systémem na národní úrovni. 

Teoretická část práce je věnována hlášení leteckých nehod a incidentů, legislativě, 
která se k němu vztahuje, konkrétně Nařízení Evropského parlamentu a Komise (EU) 
č. 376/2014, a také popisu hlášení leteckých událostí v České republice. Dále je 
popsán systém ECCAIRS, historie jeho vzniku a vývoje a jsou rozebrány základní 
nástroje a aplikace tohoto systému. Následuje část zabývající se možnostmi 
modifikací systému ECCAIRS, a to nejen pomocí sady Taxonomy Design Tools, ale 
i sady nástrojů User Interface Design. Je zde obsažen detailní popis funkcí 
jednotlivých nástrojů obou sad. 

Praktickou část představuje samotný návrh využití sady Taxonomy Design Tools 
pro zlepšení práce se systémem ECCAIRS na národní úrovni, tedy rozšíření nabídky 
zobrazení informací (náhledů) pro ECCAIRS Browser (Prohlížeč) o nové, které 
obsahuje strukturu položek odpovídající používaným formulářům hlášení událostí, 
včetně národní mutace příslušné části taxonomie. V práci je uveden popis návrhu a 
postup provedení společně s blokovým schématem posloupnosti kroků v rámci 
jednotlivých použitých nástrojů. Soubory přeložené taxonomie a nového náhledu jsou 
součástí elektronické přílohy této práce. 
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1 LETECKÉ NEHODY A INCIDENTY 

1.1 Definice 

K definici používaných pojmů poslouží predpis L13 o odborném zjišťování příčin 
leteckých nehod a incidentů, kde je Hlava 1 věnována právě definicím. 

INCIDENT (INCIDENT) 
Událost jiná než letecká nehoda, spojená s provozem letadla, která ovlivňuje nebo by 
mohla ovlivnit bezpečnost provozu. 

Jedná se o chybnou činnost osob nebo nesprávnou činnost leteckých 
a pozemních zařízení v leteckém provozu, jeho řízení a zabezpečování, jejíž 
důsledky však zpravidla nevyžadují předčasné ukončení letu nebo provádění 
nestandardních (nouzových) postupů. 

Incidenty v letovém provozu se rozdělují podle příčin na: 
a) letové, 
b) technické, 
c) v řízení letového provozu, 
d) v zabezpečovací technice, 
e) jiné. 

Mezi příčiny incidentů se zahrnují i nepředvídatelné přírodní jevy (výboje statické 
elektřiny, střety s ptáky apod.), pokud neohrozily bezpečnost letu do té míry, že byly 
hodnoceny jako vážný incident nebo letecká nehoda. 

LETECKÁ NEHODA (ACCIDENT) 
Událost spojená s provozem letadla, která se, v případě pilotovaného letadla, stala 
mezi dobou, kdy jakákoliv osoba nastoupila do letadla s úmyslem vykonat let 
a dobou, kdy všechny takové osoby letadlo opustily, nebo která se, v případě 
bezpilotního letadla, stala mezi dobou, kdy letadlo je připraveno k pohybu pro účely 
letu a dobou, kdy zastaví na konci tohoto letu a hlavní pohonná soustava je vypnuta, 
a při které: 

a) některá osoba byla smrtelně nebo těžce zraněna následkem: 
- přítomnosti v letadle, nebo 
- přímého kontaktu s kteroukoli částí letadla, včetně částí, které se od 

letadla oddělily, nebo 
- přímým působením proudu plynů (vytvořených letadlem), 

s výjimkou případů, kdy ke zranění došlo přirozeným způsobem, nebo 
způsobila-li si je osoba sama nebo bylo způsobeno druhou osobou, nebo 
jestliže šlo o černého pasažéra ukrývajícího se mimo prostory normálně 
používané pro cestující a posádku; nebo 
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b) letadlo bylo zničeno, nebo poškozeno tak, že poškození: 
- nepříznivě ovlivnilo pevnost konstrukce, výkon nebo letové 

charakteristiky letadla, a 
- vyžádá si větší opravu nebo výměnu postižených částí, 

s výjimkou poruchy nebo poškození motoru, jestliže toto poškození je omezeno 
pouze na jeden motor (včetně jeho příslušenství nebo motorových krytů); vrtulí 
(rotorových listů), okrajových částí křídel, antén, snímačů, lopatek, pneumatik, 
brzd, podvozku, aerodynamických krytů, palubní desky, krytů přistávacího 
zařízení, čelních skel, potahu letadla (jako jsou malé vrypy nebo proražení) 
nebo nevýznamná poškození listů hlavního rotoru, listů ocasního rotoru, 
přistávacího zařízení a těch poškození, která jsou zapříčiněna krupobitím nebo 
střetem s ptákem (včetně poškození krytu radarové antény na letadle); nebo 

c) letadlo je nezvěstné, nebo je na zcela nepřístupném místě. 

VÁŽNÝ INCIDENT (SERIOUS INCIDENT) 
Incident, jehož okolnosti naznačují vysokou pravděpodobnost letecké nehody, jenž je 
spojený s provozem letadla a který se, v případě pilotovaného letadla, stal mezi 
dobou, kdy jakákoliv osoba nastoupila do letadla s úmyslem vykonat let a dobou, kdy 
všechny takové osoby letadlo opustily, nebo který se, v případě bezpilotního letadla, 
stal mezi dobou, kdy letadlo je připraveno k pohybu pro účely letu a dobou, kdy 
zastaví na konci tohoto letu a hlavní pohonná soustava je vypnuta. 

ODBORNÉ ZJIŠŤOVÁNÍ PŘÍČIN (INVESTIGATION) 
Proces, prováděný za účelem prevence leteckých nehod a incidentů, který zahrnuje 
shromáždění a analýzu všech potřebných informací, vypracování závěrů včetně 
určení příčin a/nebo faktorů, které k nim přispěly, a v případě potřeby zpracování 
bezpečnostních doporučení. [6] 

1.2 Nařízení Evropského parlamentu a Rady (EU) č. 376/2014 

Hlášením událostí v civilním letectví, analýzou těchto hlášení a navazujícími 
opatřeními se zabývá Nařízení Evropského parlamentu a Rady (EU) č. 376/2014 
ze dne 3. dubna 2014. Cílem tohoto nařízení je zavést proaktivnější a empiricky 
důkladněji podložené bezpečnostní mechanismy zaměřené na předcházení vzniku 
nehod na základě analýzy všech relevantních bezpečnostních informací včetně 
informací o událostech v civilním letectví. 

Tímto nařízením se stanoví pravidla pro: 
- Hlášení událostí, které ohrožují nebo které, pokud by nebyly napraveny 

nebo řešeny, by ohrozily letadlo, osoby na palubě, jakékoli další osoby, 
vybavení či instalaci s dopadem na provoz letadla, a poskytování 
příslušných informací souvisejících s bezpečností, 
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- Analyzování a navazující opatrení ve vztahu k ohlášené události 
a informacím týkajícím se bezpečnosti, 

- Ochranu pracovníků v letectví, 
- Odpovídající využití shromážděných informací týkajících se bezpečnosti 
- Začlenění informací shromážděných do evropské centrální evidence, 
- Šíření anonymizovaných informací mezi zúčastněnými osobami, aby tak 

tyto osoby měly k dispozici informace, které potřebují ke zvýšení 
bezpečnosti letectví. 

Nařízení se vztahuje na události a jiné informace související s bezpečností 
civilních letadel, s výjimkou letadel uvedených v příloze II nařízení č. 216/2008. 
Členské státy mohou rozhodnout o tom, že se nařízení č.376/2014 bude rovněž 
vztahovat na události a jiné informace související s bezpečností letadel uvedených 
v příloze II nařízení č. 216/2008. 

Evropský parlament a Rada přijaly toto nařízení z mnoha důvodů - v Unii by měla 
být zajištěna všeobecně vysoká úroveň bezpečnosti civilního letectví a mělo by být 
vyvinuto veškeré úsilí ke snížení počtu nehod a incidentů s cílem zajistit důvěru 
veřejnosti v leteckou dopravu. Počet smrtelných nehod v civilním letectví zůstává 
v posledním desetiletí prakticky nezměněn, nicméně existují obavy, že se v příštích 
desetiletích počty nehod zvýší v důsledku nárůstu objemu letecké dopravy a zvyšující 
se technické složitosti letadel. Z dosavadních zkušeností vyplývá, že v mnoha 
případech již před samotnou nehodou poukazuje na existenci bezpečnostních 
hrozeb řada událostí a jiných nedostatků. Bezpečnostní informace tak představují 
důležitý zdroj pro odhalování aktuálních nebo potenciálních bezpečnostních hrozeb. 
[8] 

1.2.1 Osoby nahlašující události 

Hlášení leteckých událostí provádí podle nařízení tyto osoby: 

a) Velící pilot nebo kterýkoli další člen posádky v linii vedení letadla, pokud velící 
pilot není schopen podat hlášení, nebo provozovatel letadla 

b) Osoba podílející se na konstrukci, výrobě, udržování letové způsobilosti, 
sledování údržby či úpravě letadla, kteréhokoli zařízení nebo jeho části 

c) Osoba, která podepisuje osvědčení kontroly letové způsobilosti nebo ověření 
o uvolnění do provozu týkající se letadla, zařízení nebo jeho části 

d) Pracovník poskytovatele služeb letového provozu, jemuž je svěřena 
odpovědnost týkající se letových navigačních služeb, nebo pracovník letové 
informační služby 

e) Osoba zastávající funkci týkající se zajištění bezpečnosti letiště 

10 



NÁVRH VYUŽITÍ NÁSTROJE ECCAIRS 5 T A X O N O M Y DESIGN TOOLS 

f) Osoba zastávající funkci spojenou s instalací, pozměňováním, údržbou, 
opravou, renovací, letovou zkouškou nebo kontrolou leteckých navigačních 
zařízení 

g) Osoba zastávající funkci spojenou s odbavováním letadel, včetně tankování, 
sestavení nákladového listu, nakládky a vykládky, odmrazování a vlečení 
na letišti [8] 

1.2.2 Povinné a dobrovolné hlášení událostí 

Nařízení č.376/2014 rozděluje hlášení událostí na povinné a dobrovolné. Seznam 
klasifikovaných událostí v civilním letectví, které podléhají povinnému hlášení podle 
nařízení Evropského parlamentu a Rady (EU) č.376/2014, stanoví Prováděcí 
nařízení Komise (EU) 2015/1018. Toto nařízení stanovuje podrobnou klasifikaci 
událostí v rámci povinných systémů podávání zpráv podle čl. 4 odst. 1 nařízení (EU) 
č. 376/2014. Klasifikace je uvedena v přílohách I až V tohoto nařízení (viz příloha 1). 

Při vkládání informací do příslušných databází o každé povinně hlášené události 
a v co největší míře o každé dobrovolně hlášené události zajistí organizace, členské 
státy a agentura E A S A {European Aviation Safety Agency, v překladu Evropská 
agentura pro bezpečnost letectví), aby hlášení o událostech v těchto databázích 
obsahovala alespoň základní informace, které jsou uvedeny v příloze 2 této práce.[8] 

1.3 Hlášení leteckých nehod a incidentů v ČR 

Hlášení leteckých nehod a incidentů v České republice jakožto členském státu 
Evropské unie též podléhá Nařízení Evropského parlamentu a Rady č.376/2014. 
Odpovědným orgánem pro shromažďování, ukládání a vyhodnocování dat 
o leteckých nehodách na národní úrovni je v ČR Ústav pro odborné zjišťování příčin 
leteckých nehod (ÚZPLN). 

1.3.1 Ústav pro odborné zjišťování příčin leteckých nehod 

Ústav pro odborné zjišťování leteckých nehod se zabývá odborným zjišťováním 
příčin leteckých nehod, ale také podle nařízení č. 376/2014 shromažďováním, 
ukládáním a vyhodnocováním dat o leteckých nehodách na národní úrovni a jejich 
následným pravidelným odesíláním do centrální databáze. 

ÚZPLN byl zřízen dne 1. ledna 2003, je správním úřadem se sídlem v Praze. Jeho 
činnost je rozdělena do tří oddělení: Oddělení letových inspektorů, Oddělení 
technických inspektorů a Oddělení správy, rozvoje a analýz. [7] 
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1.3.2 Proces hlášení letecké události v ČR 

Osoba nahlašující událost má na výběr ze dvou možností hlášení letecké události: 
a) Hlášení přes portál ÚZPLN 
b) Hlášení přes portál Aviation Safety Reporting (Hlášení letecké bezpečnosti) 

V každém případě toto hlášení v jistém bodě procesu zpracovává ÚZPLN. 

Pro hlášení události, stejně jako úpravu podaného hlášení, prováděné přes portál 
ÚZPLN je možno použít tlačítka: 

- Hlášení událostí dle nařízení č. 376/2014, nebo 
- Aviation Safety Reporting, které uživatele přesměruje na portál Aviation Safety 

Reporting. 
Obě tyto možnosti se vztahují na všechny události související s bezpečností 

v civilním letectví kromě letadel uvedených v Příloze II nařízení (ES) č. 216/2018. 
Podle Průvodce hlášením událostí v civilním letectví ÚZPLN doporučuje použití ikony 
Aviation Safety Reporting, která umožňuje uživateli vytvořit nebo upravit formulář 
hlášení dle typu organizace a druhu hlášené události. [7] 

Portál ÚZPLN poskytuje i formuláře pro: 
- Hlášení událostí pro anexovaná letadla, vztahující se na letadla uvedená 

v Příloze II nařízení (ES) č. 216/2018, a 
- Hlášení událostí para pro hlášení událostí v parašutistickém provozu, 
Tyto události však nespadají pod nařízení č. 376/2014. Podoba tlačítek je 
na obrázku 1.1. 

AVIATION SAFETY REPORTING 
R e g . : 3 7 6 / 2 0 1 4 

HLÁŠENÍ UDÁLOSTÍ 
D L E N a ř . : 3 7 6 / 2 0 1 4 

HLÁŠENÍ UDÁLOSTÍ 
A N E X O V A N Á L E T A D L A 

( N a ř . 2 1 6 / 2 0 0 8 , p ř í l o h a II) 

HLÁŠENÍ UDÁLOSTÍ 
P A R A 

P R Ů V O D C E H L Á Š E N Í M U D Á L O S T Í 

Obr. 1.1: Tlačítka výběru formuláře na portálu ÚZPLN 
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Při výběru tlačítka Hlášení události dle nařízení č. 376/2014 má uživatel na výběr 
systém dobrovolného hlášení události, nebo systém povinného hlášení události, 
a pro oba tyto systémy je možnost zvolit si online vyplnění daného formuláře nebo si 
stáhnout offline verzi formuláře ve formátu X L S a vyplnit jej v programu MS Excel. 
Online a offline verze formulářů jsou vždy informačně shodné. Povinný i dobrovolný 
formulář je uveden v příloze 5 této práce. 

Na portálu Aviation Safety Reporting musí uživatel provést volbu mezi hlášením 
na jeho osobní odpovědnost nebo na odpovědnost organizace, pod kterou patří. 
V obou případech následuje výběr státu, který uživateli vydal jeho licenci, případně 
kde má organizace své hlavní sídlo. Při hlášení na osobní odpovědnost je pak 
uživateli k dispozici jeden formulář v online nebo offline verzi která je ve formátu 
PDF. Při hlášení na odpovědnost organizace je dále na výběr mezi pěti různými 
formuláři podle typu organizace a druhu události, všechny opět v online i offline verzi. 

Posloupnost hlášení letecké události v ČR je na obrázku 1.2. Osoba nahlašující 
událost použije formulář povinného hlášení, nebo dobrovolného hlášení. Vyplněný 
formulář dále pošle buď organizaci, pod kterou patří a která pak hlášení pošle 
na ÚZPLN, nebo přímo ÚZPLN. Odpovědní pracovníci ÚZPLN podané hlášení 
zpracují a vloží do národní databáze. Hlášení uložená v databázi si mohou 
pracovníci prohlédnout pomocí nástrojů systému ECCAIRS, které má ÚZPLN 
k dispozici. Vybraná hlášení událostí jsou pak automaticky stahována z národní 
databáze do Evropské centrální databáze, kterou spravuje středisko J R C . Středisko 
J R C může data prohlížet a analyzovat prostřednictvím vlastních nástrojů systému 
ECCAIRS. 

ČR ( » 
1 J \t 

r ^ B — i i 

[ i [ fl - Q 1 f— J EU 

L i — J § S Ü — j 

• B D Í 

1 ľ*~~ 

Obr. 1.2: Posloupnost hlášení letecké události 
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2 SYSTÉM ECCAIRS 

Databázový systém ECCAIRS je jedním z pasivních nástrojů, které jsou vyvíjeny 
ke zvýšení bezpečnosti letecké dopravy. Tento systém byl vytvořen pro hlášení 
leteckých nehod a incidentů v rámci členských států Evropské unie. Slouží 
ke shromažďování, sdílení, ukládání a analyzování informací o mimořádných 
situacích v letectví, čímž slouží k prevenci leteckých nehod a incidentů. [3] 

ECCAIRS je kooperační síť evropských úřadů pro civilní letectví (Civil Aviation 
Authorities (CAAs)) a úřadů pro vyšetřování leteckých nehod (Safety Investigation 
Authorities (SIAs)). Projekt je organizován střediskem J R C na žádost generálního 
představenstva pro mobilitu a dopravu (Directorate General for Mobility 
and Transport). J R C v rámci tohoto projektu úzce spolupracuje s agenturou EASA.[1] 

2.1 Historie systému ECCAIRS 

Evropská komise zahájila v roce 1989 studii v oblasti systémů hlášení incidentů. 
Na základě této studie bylo doporučeno založení Evropského koordinačního centra 
pro systémy povinného hlášení incidentů. V této souvislosti J R C provedlo studii 
realizovatelnosti integrace informací z různých již existujících nekompatibilních 
zdrojů. Dalším cílem bylo nabídnout společný systém hlášení nehod těm členským 
státům, které neměly automatizovaný systém hlášení. Projekt byl nazván ECCAIRS a 
byl představen v roce 1995 jako verze ECCAIRS 3. Evropská komise pak začala 
vyvíjet příslušnou legislativu, stejně jako potřebná technická řešení. V roce 2001 byla 
vytvořena verze ECCAIRS 4, která byla kompatibilní se systémem hlášení událostí 
A D R E P (The Accident/Incident Data Reporting; v překladu Hlášení dat 
o nehodách/incidentech). Vývoj tohoto systému iniciovala Mezinárodní organizace 
pro civilní letectví ICAO (International Civil Aviation Organisation) v roce 1974 
za účelem monitorování leteckých nehod a jejich následnou analýzu. V roce 2003 
byla databáze A D R E P převedena do ECCAIRS 4. Vývoj verze ECCAIRS 5 započal 
v roce 2007, přičemž J R C se rozhodlo přepracovat systém tak, aby byl lépe 
přizpůsobitelný uživatelem a aby byl použitelný pro více druhů dopravy - lodní 
a železniční, viz obrázek 1.2. Verze ECCAIRS 5 je plně funkční od roku 2011. [1 ] [2] 

Obr. 2.1: Logo ECCAIRS [5] 
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2.2 Legislativa 

Systém ECCAIRS je přímo spojený se dvěma nařízeními Evropské unie: 
- Nařízení č. 996/2010 o vyšetřování a prevenci nehod a incidentů v civilním 

letectví, a 
- Nařízení č. 376/2014 o hlášení, analýze dalším vyšetřování událostí v civilním 

letectví. 
ECCAIRS realizuje požadavky na shromažďování a šíření dat podle těchto 

nařízení v rámci zpráv o událostech i bezpečnostních doporučení. 

Informace od členských států jsou integrovány ve dvou centrálních databázích: 
- Evropský centrální archiv událostí (ECR-ECCAIRS, The European Central 

Repositories for Occurences) - požadovaný nařízením č. 376/2014, a 
- Evropský centrální archiv pro bezpečnostní doporučení (ECR-SRIS, The 

European Central Repositories for Safety Recommendations) - požadovaný 
nařízením č. 996/2010. 

Oba archivy jsou momentálně umístěny v J R C . Přístup do archivů podléhá 
striktním pravidlům a většinou je omezen na evropské kompetentní autority. [1] 

2.3 Uživatelé systému ECCAIRS 

Na obrázku 2.2 jsou znázorněny počty uživatelů a organizací využívajících systém 
ECCAIRS na jednotlivých kontinentech po celém světě. 

Obr. 2.2: Uživatelé systému ECCAIRS [1] 
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2.4 ECCAIRS Reporting System a další nástroje 

ECCAIRS Reporting System, neboli Systém hlášení, umožňuje evropským úřadům 
shromažďovat a vyměňovat si informace o dopravních nehodách a incidentech 
standardizovanou cestou. ECCAIRS Reporting System je sada softwarových 
aplikací, které společně vytváří kompletní systém pro organizace, které chtějí 
shromažďovat informace o dopravních událostech. K tomu, aby bylo možné rozlišit 
databáze pro různé druhy dopravy (leteckou, lodní a železniční), slouží nezávislá 
aplikace Taxonomy (Taxonomie). [4] 

2.4.1 Základní struktura systému ECCAIRS 

Occurrence 
Základním datovým záznamem v ECCAIRS Reporting System je Occurrence 
(Událost). Událost je jakýkoli druh nehody nebo incidentu v daném druhu dopravy. 

Repositories (Úložiště) zajišťují přístup k ECCAIRS Reporting System s využitím 
specifických taxonomií, dokumentace, oprávnění a uzpůsobení dle vlastních potřeb. 

Události jsou popsány pomocí sady vlastností (attributes), které jsou organizovány 
v tématech (topics) a souvisejících sekcích (section). 

Stejná událost může být zobrazena pomocí různých náhledů (views). 

Attributes 
Data v ECCAIRS Reporting System jsou shromážděna ve stovkách různých atributů 
(vlastností). Hodnoty těchto atributů jsou uloženy v databázi stanovené úložištěm 
ECCAIRS, ke kterému je uživatel připojen. Podle typu atributu definovaného 
v taxonomii mohou být hodnoty tohoto atributu vkládány ručně nebo vybrány 
ze seznamu předem určených hodnot. 

Sections 
Pro lepší vizualizaci a úpravu jsou atributy seskupeny v sekcích {sections). Například 
atributy „Zeměpisná šířka" a „Zeměpisná délka" místa, kde se událost stala, jsou 
seskupeny v sekci „Kde". 

Topics 
Z důvodu lepší navigace mohou být sekce rozděleny do témat (topics). Témata jsou 
hierarchicky zobrazena v Topič Tree (Strom témat), což může uživateli usnadnit 
hledání konkrétní informace o dané události. 
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Views 
Views (Náhledy) jsou různá seskupení témat v Topič Tree. Typy náhledů, které jsou 
uživateli k dispozici, závisí na úložišti, ke kterému je připojen, ale také na konkrétním 
nastavení uživatele a někdy i na podmínkách při vkládání dat události. 

Taxonomy 
Taxonomie {Taxonomy) ECCAIRS je katalog informací určující, které informace 
mohou být uloženy v ECCAIRS Repository a případně jak jsou tyto informace 
zakódovány v datových polích. Každá položka hlášení letecké nehody v ECCAIRS se 
nazývá Occurrence. Taxonomie Occurrence je složena z entities (entity) a k nim 
vztažených atributů. 

Entity reprezentují položky, ke kterým jsou přidruženy atributy. Entitou může být 
například „letadlo", které souvisí s danou událostí, apod. Každá entita může mít 
libovolné množství subentit (child entity), pro představu entita „motor" je subentitou 
entity „letadlo". Atributy pak popisují vlastnosti nebo hodnoty, které jsou spojované 
s danou entitou, pod kterou patří. [4] 

UDÁLOST 

Cizí objekt 

Poznámka 

Runway 

Posádka 

Letadlová část 

Letový prostor 

- avigačni služby 

N e b e z p e č n é z b o ž 

Osoby na letišti 

Obr. 2.3: Ukázka struktury taxonomie 
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Ukázka struktury taxonomie je na obrázku 2.3. Základem je kořenová entita (root 
entity) „Událost", ke které jsou přiřazeny subentity „Letiště", „Letadlo", „Letový 
prostor", „Navigační služby", apod. Subentity mohou mít přiřazené další subentity a ty 
zase další. Každá entita, ať už kořenová nebo subentita, obsahuje vlastní atributy 
a jejich hodnoty. 

K úpravě taxonomie slouží sada nástrojů ECCAIRS Taxonomy Design Tools, 
která bude rozebírána v další kapitole této práce. 

2.4.2 Repository (Repository Manager) 

Celá konfigurace ECCAIRS Reporting System je sestavena a uložena v Repository 
(Úložiště). Repository je jádrem každého systému ECCAIRS - slouží k vkládání, 
vyhledávání a zobrazování dat o hlášených událostech v databázi, uchovává veškeré 
informace a umožňuje správu bezpečnosti systému, jeho chování i uživatelského 
nastavení. Nejde tedy jen o databázi hlášených událostí; virtuálně řídí všechny 
aspekty systému. [16] 

Hlavní úložiště všech získaných dat je pod správou J R C a je označeno jako 
European Central Repository (ECR, v překladu Evropské centrální úložiště). Každý 
stát, který využívá systém ECCAIRS, má stanovený jeden místní orgán, který 
spravuje národní úložiště. Shromážděná data pak tento orgán posílá k uložení 
do ECR. V České republice tento úkol připadá ÚZPLN. [3] 

Získávání dat z úložiště se provádí online, přímo pomocí systému ECCAIRS, nebo 
offline, kdy správce národního úložiště obdrží e-mail s vytvořenou žádostí 
a na základě této žádosti jsou požadovaná data získána z databáze a odeslána 
původnímu tazateli. Žádost ECCAIRS dostupná na portálu ÚZPLN je v příloze 3. 

Repository je propojeno se serverem ECCAIRS, přičemž může existovat více 
těchto serverů a ty mohou být propojeny s různými Repository. Práci s Repository 
umožňuje nástroj ECCAIRS Repository Manager, který bývá nainstalován společně 
se serverem ECCAIRS. Repository Manager se spojuje se serverem ECCAIRS a ten 
zase s Repository - toto propojení funguje jak na stejném počítači, tak i na všech 
počítačích připojených k síti nebo přes internet. 

**> Connect to server X 

Domain / Server name: I E C C A I R S - P C ^ C C A I R S - P C 

I - I Cancel 

Obr. 2.4: Okno Repository Manageru pro spojení se serverem ECCAIRS [16] 
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Prvním krokem k vytvoření Repository pomocí nástroje Repository Manager je 
spojení Repository Manageru se serverem ECCAIRS, viz obrázek 2.4. 

Po spojení se serverem se již otevře hlavní okno Repository Manageru, 
viz obr. 2.5. Hlavní okno obsahuje: 

- Tři panely: 
- Repository List (Seznam úložišť) - vlevo; seznam všech úložišť 

definovaných na daném serveru 
- Repository Structure (Struktura úložiště) - uprostřed; strom položek, 

které tvoří dané úložiště vybrané v Repository List 
- Propert ies Panel (Panel vlastností) - vpravo; zobrazuje vlastnosti 

spojené s položkou, která je právě označena v Repository Structure 
- Menu bar (Lišta menu) - všechny dostupné funkce Repository Manageru 
- Toolbar (Lišta nástrojů) - funkce Repository Manageru ve formě ikon 
- Status bar (Stavová lišta) - zobrazuje informace o stavu 

F ECCAIRS 5 Repository Manager - [Repository: AVIATION] 

File Repository Structure Actions H.elp 

Ě I Q T§i £ I Update Discard | J ^ * \ 

Iii 

y 

V ^ AVIATION 
Taxonomy 

\Jf Attachments configuration 
EZ1 email configuration 
^ Security policy 

v U Profiles 
ITT1 Browser 
6̂  Conditional view 

Data Bridge 
^ Data Link 

D^ta Manager 
* ^ Deidentification 
[ftp Dictionary 
W Merge 
%j Occurrence template 
|~j Printing! template 
4^ Query 
_J Query Library 
[ 1 Security 
^ Server event handlers 
Qj Tunnel Service 

View 
& Web 

Workflow 
m Roles 
( j i Users 
fZ1 Messages 

Name 

Description 

Repository password 

Organisation identification 

Published 

Has database 

Database connection 

Indexing 

Offline usage allowed 

Automatic backup enabled 

Filter 

Default user properties: 

|Organisation: JRC - Description: Joint Research Centre of the European Commissior|p=} || 

® Yes, access allowed O **i access impeded 

® Yes, uses a RDBMS O No, only E5F files 

O Ves 

O Ves 

Country 
Department 
Email address 
First name 
Job 

Last name 
Organisation 
Phone 

® No 

® No 

S KCAIKS-PCÖ3 [139.191,3,196] 

Obr. 2.5: Hlavní okno Repository Manageru [16] 
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V tomto okně je pak možné nastavit si celé Repository podle svých potřeb, pro 
správnou funkci Repository ale není třeba nastavovat úplně vše. Nezbytné je 
nastavení hlavních vlastností Repository: 

- Name (Název Repository) 
- Organisation identification (Identifikace organizace) 
- Database connection (Propojení databáze) 

Taxonomy (Taxonomie) 
Dále je nutné vytvořit hlavní profily: 
- Browser Profile (Prohlížeč) - definuje, jak se bude chovat hlavní aplikace 

ECCAIRS pro Windows 
- Security Profile (Bezpečnost) - nastavení bezpečnosti Repository 

View Profile (Náhled) - definuje způsob, jakým uživatel interaguje s daty 
hlášených událostí uložených v Repository 

Nyní je třeba v položce Roles (Role) vytvořit novou roli. Role představuje soubor 
profilů a potřebuje mít minimálně výše zmíněné profily Browser, Security a View, 
a nakonec zbývá vytvořit v položce Users (Uživatelé) nového uživatele, který je 
přiřazen určité roli a převezme všechny profily definované v této roli. Pomocí funkce 
Repository > Validate je možné zkontrolovat vnitřní strukturu Repository a také její 
kompatibilitu s přiřazenou taxonomií. Celý proces je třeba uložit pomocí funkce Save 
changes nebo Update. [16] 

2.4.3 Query 

Informace o vybraných událostech jsou z databáze získávány pomocí Query (Dotaz), 
které je sestaveno uživatelem. Dotazy jsou vytvářeny pomocí tzv. QueryBuilderu 
(Vytváření dotazů) a samotná formulace dotazu je velice jednoduchá, bez potřeby 
znalosti programování. Základním blokem dotazu je kritérium {criterion), což je 
požadavek na konkrétní atribut. Kritérium může být postaveno na jakémkoli atributu 
současné taxonomie. Je také možné provádět kombinace kritérií pomocí logických 
operátorů AND (A) a OR (NEBO). 

Na obrázku 2.6 je uveden příklad kritérií dotazu. Podle tohoto dotazu mají být 
vybrány události, kde atribut „Množství oblačnosti" odpovídá hodnotě „Zataženo" 
a zároveň atribut „Viditelnost" odpovídá hodnotě „Méně než 100" (jednotkou jsou 
v tomto případě stopy - feet). 

í 
T h e a m o u n t o f c l o u d { O c c u r r e n c e ) - [ V a l u e ] e q u a l t o ' O v e r c a s t ' 

AND 
V i s i b l i t y { O c c u r r e n c e } [ V a l u e ] l e s s t h a n ' 1 0 0 ' 

Obr. 2.6: Příklad Dotazu (Query) [4] 
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Dotazy si lze uložit do QueryLibrary (Knihovna dotazů), přičemž tato knihovna 
může obsahovat libovolné množství těchto dotazů. Knihovna dotazů umožňuje 
vytvářet, upravovat i mazat dotazy a uspořádat dotazy do skupin. Dotazy také mohou 
být v rámci Knihovny dotazů přiřazeny k určité kategorii (categorý) a uživatel si tak 
může dotazy logicky uspořádat. [4] 

2.4.4 E C C A I R S Browser 

ECCAIRS Browser neboli Prohlížeč je klíčovým komponentem ECCAIRS Reporting 
System. Umožňuje vkládat, upravovat, zobrazovat a vyhledávat data o událostech 
uložených v databázi. Browser umožňuje komplexní a jednoduché nahlížení na data 
jednotlivých vložených událostí. 

J* ECCAIRS 5 Browser - File: [C:\Users\Sarka\De5lct0pVDP ECCAIRS\2014.e5f] 

File Edit View Database Occurrence Help 

A 1 1 ' i - s |i a \"& e3 a a m i f c 

i s - r s i o i 

• X 

Q I O I ^ % éš l a <1 -1 

View with: [H OPERATIONAL FULL 

Czech Republic - A M , CZ-14-C01 

["] Reports 
| f l Attachments 
! 0 Narrative (Czech) 

O Narrative (English) 
/ Events and factors 

I Weather 

fk ^ C E S S N A - 1 7 2 - H , O K - A C P 

! EH Persons on hoard and medica 
I ^ History of flight 

> •$ Air traffic services 

3 § Aerodrome (LKRO : Roudnice) 
3 ^ Airspace [ROUDNICE) 
•IB Management 

Headline 

Headline / Nadpis Fall of ACFT 

Occurrence filing information 

File number / Oslo CZ-14-001 

Occurrence status / Closed 

Occurrence AAII - JP r LP 

Detection phase 
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Obr. 2.7: Okno ECCAIRS Browser 
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Hlavní okno nástroje Browser je na obrázku 2.7. Skládá se z několika základních 
prvků: 

- Menu bar (Lišta menu) - umožňuje přístup ke všem funkcím Browseru 
- Toolbar (Lišta nástrojů) - sada pro rychlejší přístup k funkcím Browseru 
- Information Panel (Informační panel) - plocha, na které jsou zobrazována 

data o události; obsahuje dva subpanely: 
- Topic-tree sub-panel (Strom témat) - vlevo, zobrazuje témata dané 

události uspořádaná ve stromové struktuře 
- Topic-data sub-panel (Data tématu) - vpravo, zobrazuje informace 

o dané události prostřednictvím atributů a jejich hodnot rozdělených 
do sekcí, které jsou přiřazeny tématu zvolenému ve stromu témat 

- Occurrence List Panel (Panel seznamu událostí) - zobrazuje seznam 
dalších událostí nalezených v databázi podle zadaného dotazu (Querý) 

- Status bar (Stavová lišta) - zobrazuje základní informace o uživateli, počtu 
událostí v panelu seznamu událostí, počtu vybraných událostí, o taxonomii, 
atd. 

Browser umožňuje vytvářet nové události pomocí funkce Occurrence > New. 
Je třeba vybrat náhled, ve kterém bude uživatel informace vyplňovat, viz obrázek 2.8. 
Události je možné i duplikovat, upravovat, mazat, tisknout nebo převést do formátu 
PDF. 

9 ECCAIRS 5 Browser - File: [C:\Users\Sarka\Deslctop\DP ECCAIRS\2D14.e5f] 
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I E FORMLJLAR 

Obr. 2.8: Vytvoření nové události v ECCAIRS Browser 

V databázi hlášení událostí lze události filtrovat pomocí Query. Prostřednictvím 
funkce Database > Built query se otevře nové okno, kde se funkcí Library > New 
vytvoří knihovna dotazů, ve které je možné vytvářet a ukládat do ní dotazy, 
viz obrázek 2.9. 
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Query Library:'New Library' 

Library Category 

Ĺ a- ď I y a i 
New Library 
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Edit 
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Assign to Category 

Cut 

Copy 

Paste 

Pjä Importfrom Library, 

Q> Export to Library,,. 

? Definition 

[Tg" Description 

Ctrl+X 

Ctrl + C 

Ctrl+V 

Query Name Category Author 

Obr. 2.9: Knihovna dotazů [4] 

Funkce View > View with umožňuje uživateli vybrat si náhled, pomocí kterého 
budou zobrazeny informace obsažené v hlášení události, viz obrázek 2.10. 
Po instalaci systému ECCAIRS je několik základních náhledů již zabudovaných. 
Je také možné vybrat si, jaké funkce budou zobrazeny v Liště nástrojů a jestli bude 
zobrazen panel seznamu událostí. 

ECCAIRS 5 Browser - File: [C:\Users\Sarlca\Deslctop\DP ECCAIRS\2D14.e5f] 
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Obr. 2.10: Výběr náhledu pro ECCAIRS Browser 
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Barevnost uživatelského prostředí lze měnit pomocí funkce View > Options > 
Appearance, viz obrázek 2.11. [4] 

© ECCAIRS 5 Browser - File: [C:\User5\Sarka\Desktop\DP ECCAIRS\J014.e5f] 
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Obr. 2.11: Úprava barevnosti uživatelského prostředí 

2.4.5 E C C A I R S Grapher 

ECCAIRS Grapher je nástroj pro vytváření grafů, který vytváří nejpoužívanější 
statistické grafy. Ačkoli Grapher není nástroj zcela vybavený pro datovou analýzu, 
tato aplikace umožňuje vytvářet celou řadu grafů, které ilustrují trendy z vložených 
Událostí. Je možné vytvářet 2D i 3D grafy a ukázat tak závislost mezi dvěma nebo 
třemi parametry. Základní data grafu mohou být importována do různých aplikací, 
jako například MS Excel. 

Grafy se skládají ze 4 základních elementů: 
- Dotaz, který definuje podmnožinu událostí z databáze, která je použita 

k vytvoření grafu 
- Osa X definovaná elementy z databáze (hodnoty určitých vlastností), které 

jsou zobrazeny v grafu horizontálně 
- Osa Y definující datové série vykreslené v grafu pro každou hodnotu osy X. 

Data na ose Y mohou být 2 typů: databázové dotazy plynoucí z hodnot nebo 
jiných vlastností, nebo výpočty z jiných datových sérií 

- Volitelná osa Z, která definuje kategorie pro vykreslení X a Y přidáním třetí 
dimenze do grafu 
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Hlavní okno ECCAIRS Grapher (viz obrázek 2.12) se skládá ze tří částí: 
- Menu bar (Lišta menu) - umožňuje přístup ke všem funkcím Grapheru 
- Toolbar (Lišta nástrojů) - sada pro rychlejší přístup k vybraným funkcím 

Grapheru 
- Workspace (Pracovní plocha) - kde je zobrazena Graph Library (Knihovna 

grafů) a otevřené grafy [4] 

( í ÍCC IW5 5 Gf . ip l i rT 

F i t L d t &tfh O p t m s VMnrfcw H d p 

• l £ B ť * | i l M £ S l V l p l M f i : • $ 

C w p p m 4$urKnüwnargsriaftbn AVI ATI Ofl 2 2010-11-29 1211 ^ 

Obr. 2.12: ECCAIRS Grapher [4] 

2.4.6 E C C A I R S Data Manager 

ECCAIRS Data Manager je aplikace obsahující sadu výkonných nástrojů 
pro ECCAIRS Reporting System. 

Nástroj Exportér (Exportér) umožňuje vytváření vlastních upravených zpráv, 
vyhledávání textu na základě hodnot atributů, předávání dat do nekompatibilních 
systémů se systémem ECCAIRS nebo vytváření de-identifikovaných souborů. 

Nástroj Data Exchanger (Výměna dat) obsahuje čtyři základní funkce: 
1) Načítání dat ze souboru události 
2) Ukládání dat do souboru události 
3) Kopírování dat mezi jednotlivými úložišti 
4) Odstraňování všech událostí z úložiště 
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Nástroj Restorer (Obnovení) slouží k případnému obnovení a identifikování de-
identifikovaných souborů. 

Nástroj Data Quality (Kvalita dat) slouží ke kontrole kvality dat obsažených 
v hlášení události. Kvalita dat je vyhodnocována na základě pravidel umístěných 
v tzv. Rule Libraries (Knihovny pravidel). [4] 

2.4.7 Ostatní apl ikace E C C A I R S 

Sada produktů ECCAIRS je složena z mnoha aplikací, které umožňují vytvářet 
a spravovat databázi hlášení leteckých událostí. Mimo již zmíněných aplikací 
a nástrojů existují i aplikace pro: 

- Data Entry and Retrieval (Vkládání a vyhledávání dat) je aplikace, která 
vkládá data o nehodách a incidentech do ECCAIRS Repository 

- Analysis (Analýza) - aplikace napomáhající při analýze uložených dat 
- Utilities (Služby) - užitečné aplikace, které zastávají funkce, které nejsou 

dostupné v rámci standardního softwaru, a jsou užitečné pro koncové 
uživatele systému 

- System Tools (Systémové nástroje) - usnadňují údržbu systému ECCAIRS 
- Data Integration (Integrace dat) - aplikace potřebné k provedení integrace 

dat na národní a evropské úrovni 
- Data Dissemination (Šíření dat) - umožňují šíření dat na úrovni organizace, 

státu nebo Evropské unie. [4] 
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3 MOŽNOSTI MODIFIKACÍ SYSTÉMU ECCAIRS 

Verze ECCAIRS 5 umožňuje uživatelům podílet se na vymezení taxonomie a upravit 
si svoji vlastní taxonomii. K tomu jsou určeny Taxonomy Projects a sada Taxonomy 
Design Tools. Taxonomy Projects obsahují reálnou strukturu, entity a jejich relace, 
atributy a jejich hodnoty. Na základě Taxonomy Projectu může být generován 
Taxonomy File, neboli Dictionary, a ten může být použit jako vstup pro design 
rozhraní. [11] 

Design uživatelského rozhraní je pak možno upravovat pomocí sady User 
Interface Design. Tato sada nástrojů umožňuje editovat nebo vytvářet vlastní sekce 
a náhledy. Výsledkem tak může vlastní zobrazení dat hlášených událostí v ECCAIRS 
Browseru. 

3.1 ECCAIRS 5 Taxonomy Design Tools 

Sada Taxonomy Design Tools (TaxDes) je složena z pěti nezávislých nástrojů: 

- Administrat ion - správa taxonomie 

- Manager - správa taxonomie 
- Customisat ion - úprava atributů taxonomie 
- Translation - překlad atributů taxonomie 
- Value Manager - úprava hodnot atributů taxonomie [11 ] 

Jednotlivé nástroje budou podrobněji rozebrány v následujících kapitolách. 
Nástroje TaxDes Administration a TaxDes Manager jsou určeny pouze pro vybrané 
organizace, proto se tato práce bude více soustředit na nástroje, které jsou dostupné 
běžným uživatelům systému ECCAIRS. 

3.1.1 Taxonomy Designer (Administration) 

Tento nástroj je dostupný pouze organizaci J R C . Umožňuje: 
- Vytvářet novou taxonomii 
- Upravovat taxonomii (strukturu, hodnoty) 
- Vytvářet upravitelné atributy (Custom Atributes) 
- Vytvářet vydání (Release) 
- Exportovat/importovat vydání 
- Generovat překládači projekt (Translation Project) 
- Importovat překládači projekt 
- Generovat skripty pro databáze 
- Vytvářet soubor taxonomie (Taxonomy Dictionary) [11 ] 
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3.1.2 Taxonomy Designer (Manager) 

Nástroj Taxonomy Designer (Manager) je dostupný pro J R C a agenturu EASA. 
Rozsah jeho funkcí je mírně omezený oproti nástroji Administration. Umožňuje: 

- Upravovat taxonomii (strukturu, hodnoty) 
- Vytvářet upravitelné atributy 
- Vytvářet vydání 
- Exportovat/importovat vydání 
- Generovat překládači projekt 
- Importovat překládači projekt 
- Vytvářet soubor taxonomie [11 ] 

3.1.3 Taxonomy Designer (Customisation) 

Taxonomy Designer (Customisation) lze využít v módu Custom nebo Profile. Funkce 
v obou módech jsou velice podobné. V módu Custom je možné: 

- Vytvořit projekt na základě jednotné taxonomie {Custom Project) 
- Upravit upravitelný atribut 
- Vytvořit seznam hodnot pro upravitelné atributy 
- Vytvářet vydání 
- Exportovat/importovat vydání 
- Vytvářet soubor k úpravě taxonomie {Custom Dictionary) 

V módu Profile\e možné: 
- Vytvořit projekt na základě jednotné taxonomie {Profile Project) 
- Upravit atribut 
- Měnit povinnost vyplnění atributů 
- Filtrovat hodnoty pro specifický seznam hodnot 
- Vytvářet vydání 
- Vytvářet soubor k úpravě taxonomie 

Úprava taxonomie probíhá v okně Working Draft (Pracovní návrh), 
viz obrázek 3.1. Okno Working Draft obsahuje: 

- Tři panely: 
- Entity list panel (Seznam entit) - vlevo, zobrazuje všechny entity 

a subentity obsažené v dané taxonomii a jejich vzájemné vztahy 
- Atribute list panel (Seznam atributů) - uprostřed, zobrazuje atributy 

vložené v entitě, která je právě označena v Entity list panelu 
- Atribute properties panel (Vlastnosti atributu) - vpravo, zobrazuje 

vlastnosti atributu, který je právě označen v Atribute list panelu 
- Atribute Filtering and Navigation bars (Lišta filtrování a navigace mezi 

atributy) - umožňuje filtrovat a vyhledávat atributy na základě taxonomie, 
skupiny, typu nebo přímo pořadového čísla atributu 
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- Menu bar (Lišta menu) - obsahuje všechny dostupné funkce nástroje 
- Toolbar (Lišta nástrojů) - obsahuje funkce nástroje v ikonách 
- Status bar (Stavová lišta) - zobrazuje informace o souboru 
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Obr. 3.1: Okno Working Draft nástroje Tax Des Customisation 

Nástroj TaxDes Customisation umožňuje především editovat upravitelné atributy, 
které jsou součástí každé verze taxonomie (na obrázku 3.1 jsou psané zeleně 
kurzívou), pomocí funkce Customize Atribute. Samotná úprava probíhá v Properties 
panelu - lze měnit název, popis, detailní popis, vysvětlení, povinnost vyplnění 
hodnoty atributu, apod. 

Mezi další funkce patří tisk zpráv o taxonomii nebo jejich generování ve formátu 
PDF prostřednictvím funkce Taxonomy > Print Preview, resp. Taxonomy > Generate 
PDF, kdy se otevře nové okno s výběrem předvolených zpráv o taxonomii a dalšími 
možnostmi úpravy zprávy. Funkce Taxonomy > Update Taxonomy uloží provedené 
změny v souboru a pomocí funkce Taxonomy > Check Structure lze zkontrolovat 
správnost úprav. 

Verze se vytváří pomocí funkce Make Release. Po otevření vytvořené verze se 
zobrazí okno podobné oknu Working Draft, jsou zde ale dostupné jiné funkce, 
viz obrázek 3.2. V tomto okně již nelze upravovat atributy. 
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Funkce Translation > Generate Translation Project umožňuje vygenerovat 
Translation Project určený k překladu taxonomie v nástroji TaxDes Translation. 
Přeložený soubor Taxonomy Project lze importovat zpět prostřednictvím funkce 
Translation > Import Translation Project. 
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everts Group by M tributes I ' für Id: P • 1 Attribute ID 19 
everts 

Description Validation taxonomy name p u hcrcign Jb.ec: Attr.id Detailed Taxonomy Ref. Group Name 
Description Validation taxonomy name 

c 5 
e 

Attr.id Detailed Taxonomy Ref. Group Name 
Detailed Validation taxonomy name 

H i Validation taxonomy name Current Taxonomy Other 
Detailed Validation taxonomy name 

20 Validation taxonomy version Current Taxonomy Other V 

35 Dew point temperature Current Taxonomy Other Explanation The name of the taxonomy in 
ô 1 e 

[ 5 Aerodrorre Weather Resorts 
3 ( 5 A ' Ndvigdlior Sen/cje 

127 Weather conditions Current Taxonomy Other which the occurrence was last 
saved, 

[ 

ô 1 e 
[ 5 Aerodrorre Weather Resorts 

3 ( 5 A ' Ndvigdlior Sen/cje 
129 Dangerous goods involved Current Taxonomy Other 

which the occurrence was last 
saved, 

( 5 A~M reccrding dsvires V 140 Height of cloud base Current Taxonomy Other 
< | 163 Ught conditions Current Taxonomy Other 
Definition 176 Maximum wind gust Current Taxonomy Other 

Entity ID 14 266 The amount of cloud Current Taxonomy Other Entity ID 
275 Wind speed measured at Current Taxonomy Other 275 Wind speed measured at Current Taxonomy Other 

Description Occurrence 237 Ar temperature Current Taxonomy Other 
V 

Detailed Occurrence 310 Visibility Current Taxonomy Other Group None 

320 Wind direction Current Taxonomy Other Taxonomy Ref. Current Taxonomy 
V 321 Wind gusts Current Taxonomy Other 

V 
Entity Occurrence 

Explanation General A •m 1 l" 1 T~ Custom Attr. No 
information V V 

Default Language ; English Current Language : English 

Obr. 3.2: Okno verze v TaxDes Customisation 

I v tomto okně lze tisknout zprávy o taxonomii nebo je generovat ve formátu PDF 
pomocí funkcí Taxonomy > Print Preview, resp. Taxonomy > Generate PDF. Funkce 
Taxonomy > Export Description vytvoří soubor ve formátu X L S s tabulkou všech entit 
v taxonomii s jejich popisem v abecedním pořádku, nejsou tedy patrné relace mezi 
entitami. Funkce Taxonomy > Export Statistics for Value list vytvoří soubor 
ve formátu X L S s tabulkou seznamu hodnot pro jednotlivé atributy v taxonomii, 
včetně jejich popisu, pokud je zadán. 

Výstupem úpravy taxonomie v TaxDes Customisation je upravovací soubor 
taxonomie, tzv. Custom Dictionary, který je možné generovat funkcí Generate > 
Make Custom Dictionary. Soubor Custom Dictionary má příponu .cust a je použitelný 
v mnoha dalších nástrojích systému ECCAIRS, například v dále zmíněném Section 
Designéru nebo View Desgineru, které vytvářejí projekty na základě taxonomie, a při 
použití Custom Dictionary jsou schopné pracovat i se změnami v taxonomii 
uloženými právě v tomto souboru. [11] 

3.1.4 Taxonomy Designer (Translation) 

Taxonomy Designer (Translation) je nástroj sloužící k překladu atributů taxonomie. 
Překlad se uskutečňuje v Translation Project souboru (přípona .etpt), který byl dříve 
generován z vydání Customisation Projedu v nástroji TaxDes Customisation. 
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Po otevření Translation project souboru se otevře překládači okno nástroje 
TaxDes Translation, viz obrázek 3.3. Toto okno obsahuje: 

- Workspace (Pracovní prostor) - je rozdělený na dva panely: 
- Item-list panel (Seznam položek) - vlevo, zobrazuje položky, které 

mohou být přeloženy 
- Translation panel (Překládači panel) - vpravo, slouží k přímému 

překladu položky, která je právě označena v Item-list panelu 
- Menu bar (Lišta menu) - umožňuje přístup ke všem funkcím nástroje 
- Toolbar (Lišta nástrojů) - zobrazuje funkce nástroje jako ikony 
- Status bar (Stavová lišta) - zobrazuje informace o souboru 

H Translation TcolíTJe^ Custom 20174103 1.0.2.0 cs.etpt] 

File Edit View 
E B B 

TableType: Taxonomy Tables T 1 Attributes - I Statu; 

B 

617 Actual sector bad 
1 Aerodrome latitude 
2 Aerodrome longitude 
7 Aerodrome status / Status letiště 
10 Aerodrome type / Druh letiště 
333 Age 
479 Age 
401 Age J Věk 
353 Age of ATM license 
237 Ar temperature 
1052 AT Waybill/ Consignment 
22 
32 

Arcraft altitude / Aktuáln i výská letadla 
Arcraft category / Kategorie letadla 

635 Arcraft damage .•• Poškozen I letadla 
25 
26 

Arcraft flight level .•' Aktuáln' letová hladina 
Arcraft height 

556 Arcraft lighting 
244 
291 

Arcraft registration / Poznávac i značka 
Arcraft total time . Celk:va doba provozu letadla 

13 Arspace class / Třida vzdušného prostoru 
H 1 4 Název vzdušného prostoru 

15 Arspace type / Druh vzdušného prostoru 
252 Arspeed 
35 
74 

Arworthiness čert. .•' Osvědčen' letové způsobilosti 
Altitude contours v 

<• > 

Description 

Original JAirspace n 

Translation | Název vzdušného prostoru  
Detailed Description 

Oiigina. Airspace name 

Název vzdušného prostoru 

Cepy I 

Explanation 

Original The name of the airspace. 

Total count:349 3tal Traslated : Current Language: Czech Default Language: English 

Obr. 3.3: Překládači okno nástroje TaxDes Translation 

Překlad položek se provádí v Translation panelu, který je rozdělen na sekce 
Description (Popis), Detailed Description (Detailní popis) a Explanation (Vysvětlení). 
Každá tato sekce obsahuje pole pro originální a pro přeložený text, přičemž 
po vepsání přeloženého textu pole pro přeložený text zezelená. Je možné zkopírovat 
originální text do překládacího pole pomocí funkce Copy (Kopírovat). Lze také 
obnovit původní texty všech přeložených položek prostřednictvím funkce 
Edit > Restore Originál Values. Funkce Edit > Search umožňuje vyhledávat položky 
v taxonomii. 

Není nutné překládat položky přímo v TaxDes Translation. Pomocí funkce File > 
Export to Excel lze soubor převést do formátu X L S a překlad provést v MS Excel. 
Přeložený soubor je následně importován zpět funkcí File > Import from Excel. 

I zde je možné tisknout zprávy o taxonomii nebo je generovat ve formátu PDF, 
stejně jako v nástroji TaxDes Customisation. [12] 
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3.1.5 Taxonomy Designer (Value Manager) 

Tento nástroj umožňuje organizacím spravovat hodnoty atributů (především v jejich 
národní databázi), konkrétně upravovat hodnoty ve specifickém seznamu hodnot 
nebo větvi seznamu hodnot. TaxDes Value Manager pracuje se soubory Value List 
Project, které je možné generovat pomocí nástroje TaxDes Manager, kdy je pak 
možné upravovat hodnoty všech atributů, nebo TaxDes Customisation, kdy je možné 
upravovat pouze hodnoty upravitelných atributů. 

Po otevření Value List Project souboru se otevře okno Value List Management, 
viz obrázek 3.4. Okno sestává z: 

- Menu bar (Lišta menu) - obsahuje všechny dostupné funkce okna 
- Toolbar (Lišta nástrojů) - funkce okna ve formě ikon 
- Central panel (Centrální panel) - zobrazeny seznamy hodnot k úpravě 
- Status bar (Stavová lišta) - informace o stavu souboru 

V a l u e L is t M a n a g e m e n t ( E n t i t y _ V a l u e - P r o i e c t _ 2 - l e v e l s . e t p ) 

F i le Ed i t V iew 

-IDI * l 

D e s c r i p t i o n Levels 

Total Value list: I 

Obr. 3.4: Okno Value List Management [13] 

Dvojklik na daný seznam hodnot nebo funkce Edit > Values otevře okno Manage 
Values for List, viz obrázek 3.5, které obsahuje: 

- Menu bar (Lišta menu) - všechny dostupné funkce okna 
- Toolbar (Lišta nástrojů) - funkce okna ve formě ikon 
- Dva pracovní panely: 

- Value Tree Navigation Panel (Navigační panel stromu hodnot) -
zobrazuje hodnoty v seznamu hodnot a jejich relace 

- Value Propert ies Panel (Panel vlastností hodnoty) - zobrazuje 
vlastnosti dané hodnoty označené v navigačním panelu 

- Status bar (Stavová lišta) - zobrazuje informace o stavu souboru 
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^ M d ľ i t i y e V d l u Ľ i fui Iii L : e i iULy 

Filc V i c ^ E d t To als 

U T Ě Š ] * 1 * Úf O I Manage Alas 

I d e n t i f i c a t i o n 

Value ID 3 

Description Switzerland 

Detailed Switzer land J 

d 
Explanation ±1 

Epecial Value Normal -

- V EUROPE 

bi;, 

t Spain 

% Belgium 

ŕ francc 

ŕ Switzerland 

t / S A 

í§ f unknown 

Value Alias 

Alias Nama Value Default 

-Ěl -Él-Sj 

0£>r. 3.5: O/cno Manage Values for List [13] 

Pomocí menu tlačítka Edit je možné přidávat hodnoty {Add Value), přidávat 
subhodnoty {Add Child Value), mazat hodnoty {Remové Value), obnovovat hodnoty 
{Restore Value) a přeskupovat pořadí hodnot ve struktuře stromu pomocí šipek. 
Každou hodnotu lze upravit v panelu vlastností. 

Soubor Value List Project je možné exportovat do programu MS Excel 
prostřednictvím funkce File > Export to Excel. Upravený soubor z MS Excel 
se importuje zpět do nástroje Value Manager funkcí File > Import from Excel. 

Tisk zpráv umožňuje funkce File > Print Preview a generování zpráv do formátu 
PDF funkce File > Generate PDF File. [13] 

3.2 ECCAIRS User Interface Design 

Náhledy zabudované v ECCAIRS při instalaci nemusí vždy všem organizacím nebo 
přímo jednotlivým uživatelům vyhovovat. K tomu je určena právě sada User Interface 
Design, která sestává ze dvou nástrojů: 

- Sect ion Designér - pro úpravu již vytvořených a vytváření nových sekcí 
z atributů taxonomie 

- View Designér - pro úpravu nebo vytváření nových náhledů ze sekcí 
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3.2.1 Sect ion Designer 

Systém ECCAIRS ukládá data související s událostmi ve stovkách různých atributů. 
Hodnoty těchto atributů jsou uloženy v databázi ECCAIRS. Některé atributy se týkají 
přímo události (např. datum události), jiné atributy se vztahují ke specifické subentitě 
události (např. subentity letadlo, letiště, apod.). Pozn.: Pokud se události účastnilo 
více letadel, každé má pak svoji subentitu s vlastními atributy a jejich hodnotami. 

Pro lepší vizualizaci a možné úpravy jsou atributy seskupovány v sekcích. Nástroj 
Section Designer pak umožňuje organizacím využívajícím systém ECCAIRS vytvářet 
a upravovat jejich vlastní sekce. 

Samotný Section Designer je součástí sady ECCAIRS User Interface Design 
(Design uživatelského prostředí) a kromě vytváření nových sekcí umožňuje také 
kombinovat různá rozvržení zobrazení, vkládat text, názvy atributů a ovládání 
pro hodnoty atributů. 

Při vytváření nové sekce (Section Project), viz obrázek 3.6, je nutné specifikovat 
soubor taxonomie [Taxonomy Dictionary) a jednu z entit, nejčastěji tzv. kořenovou 
entitu - událost, na kterých bude tato sekce založena. V dané sekci je pak možné 
pracovat pouze s atributy příslušejícími k této entitě, případně k jejím subentitám. 
Ve formuláři pro vytvoření nové sekce si lze zvolit název sekce (tento údaj je 
povinný), popis sekce, detailní popis sekce, číslo vydání a je možné vložit editovací 
soubor. 

New Section 

Section Name: 

Description: 

Detailed: 

Taxonomy: 

Default Language: 

I I Use Customisation 

I I Use domain filter 

Based on Entity: 

Release: | l | |u | |u | |o 

® Root entity 

O Specific Entity 

O No Entity 

Cancel 

Obr. 3.6: Formulář vytvoření nové sekce v nástroji Section Designér 

Do polí pro název a popisy sekce lze vepsat nebo vložit jakýkoli text. Číslo verze 
tvoří čtyři čísla, jejichž význam je popořadě hlavní vydání [major release), vedlejší 
vydání (minor release), revize [revision) a sestavení (build). Výchozí číslo verze je 
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1.0.0.0 a lze upravit. Editovací soubor se používá, pokud jsme například potřebovali 
pomocí Taxonomy Designér (Customisation) doplnit další atributy úpravou 
editovatelných atributů. Editovací soubor je pak generován přímo z nástroje TaxDes 
Customisation a má příponu .cust. 

Vlastní editace sekce probíhá v hlavním okně Section Designéru, viz obrázek 3.7. 
Okno obsahuje: 

- Menu bar (Lišta menu) - všechny dostupné funkce Section Designéru 
- Toolbar (Lišta nástrojů) - všechny dostupné funkce Section Designéru 

zobrazené pomocí ikon 
- Toolbox panel (Panel nástrojů) - vlevo, pro specifikaci druhu prvku 
- Canvas panel (Panel tabulky sekce) - uprostřed, tabulka sekce, kam jsou 

vkládány prvky 
- Propert ies panel (Panel vlastností) - vpravo, vlastnosti týkající se celé sekce 

nebo vybraného prvku 
- Layout switch tab-bar (Lišta výběru rozvržení zobrazení) - výběr rozvržení 

zobrazení 
- Status bar (Stavová lišta) - informace o sekci (taxonomie, název sekce, číslo 

vydání, atd.) 

Každá sekce může být přizpůsobena, aby vyhovovala různým zobrazovacím 
módům nebo médiím, přičemž tyto módy a média mohou vyžadovat různá umístění 
a velikost políček atributů, panelů, apod. Při vytváření sekce je možné použít jedno 
z pěti rozvržení zobrazení: 

- Windows Form Edit (Upravitelné zobrazení pro Windows) - pro zobrazení 
a úpravu dat v sekci při použití ECCAIRS Browser pro Windows; 
toto rozvržení je výchozí 

- Windows Form Read-Only (Zobrazení pro Windows pouze pro čtení) -
pro zobrazení dat v sekci při použití ECCAIRS Browser pro Windows 
bez možnosti úpravy 

- Web Form Edit (Upravitelné zobrazení pro web) - pro zobrazení a úpravu dat 
v sekci při použití aplikace WebDAS 

- Web Form Read-Only (Zobrazení pro web pouze pro čtení) - pro zobrazení 
dat v sekci při použití aplikace WebDAS bez možnosti úpravy 

- Report (Zpráva) - pro zobrazení dat v sekci ve verzi pro tisk 
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SECTION DESIGNER: novasekce 

File View Edit Formst 

I- G tí H Q : • % 
Toolí- Script Help 

© l E i m i i x z & \B Font Name Microsoft San^ Serif 

Toolbox 
•=1 Attribute Def. + Value 
™ Attribute Definition 
""' Attribute Value 

Entity Definition 
_ l Enüty List 
^Entity Tree 

ED Entity Panel 
j ~ Entity Selector 
LUES Entity List Selector 
m Entity Link 

Layers Panel 
A Free Tent 
TT Unbound Control 
@ Table Panel 

Attribute Def. + Value 

-••[gl 24 - Occurrence t 
1 19 - Validation taxonomy na 
I 20 - Validation taxonomy ve 
I 35 - Dew point 
I 127 - Weather conditions 
I 129 - Dang goods involved / 
1 140 - Height of doud base 
I 1SS - Light conditions / Svet 
I 176 - Maximum gust 
1 266 - Cloud amount 
I 275 - Speed measured at 
• 287-Air temperature 

S ] [ Y ] 

ECCAIRS Aviation (4.1.0.3) T"l novasekce 

t « a w « dl | B / I í T IT 331! Eä ft ÉÉ 

Properties 
General 

Name 

Type 

Description 

Detailed Description 

I SECTION 

Default Language 

Environment 

Type 

Taxonomy 

Taxonomy Name 

Taxonomy Release 

Applicable to 

Filter by domain [no filter) 
Customisation 

ECCAIRS Aviation 

Customisation Manie J-lo Customisation) 

Customisation Rel, [No Customisation) 

HÜOccurrence [Ent,Id=24) ^ novasekce1 JTÍ 604 x 168 

Obr. 3.7: Hlavní okno Section Designéru 

Základní podobu sekce lze nastavit v hlavním okně Section Designéru pomocí 
vybrání nabídky View > Options, která otevře okno se čtyřmi záložkami: 

- Sect ion Propert ies (Vlastnosti sekce) - umožňuje určit počet sloupců a řádků 
sekce, vybrat, které rozměry buněk se budou automaticky měnit se změnou 
velikosti okna, kde bude výsledek zobrazen, a jestli bude viditelný okraj sekce 

- Table Propert ies (Vlastnosti tabulky) - lze měnit výchozí šířku sloupců 
a výšku řádků a opět vybrat, které rozměry buněk se budou automaticky měnit 
se změnou velikosti okna 

- Control Propert ies (Vlastnosti prvku) - možnost měnit výchozí šířku a výšku 
prvků vkládaných do tabulky (tyto rozměry měly být vždy menší, než jsou 
rozměry buňky, aby byl zobrazen celý obsah prvku) a volit velikost okrajů 
v buňce, zarovnání a pozici textu 

- Font Propert ies (Vlastnosti písma) - umožňuje výběr fontu a velikost textu 
obsaženého v prvcích 

Uživatel si může vybrat ze seznamu použitelných prvků v Toolbox Panelu vlevo 
takový druh prvku, jaký právě potřebuje (např. atribut, jeho hodnotu, entitu, vlastní 
text, obrázek, atd.). Je možné si zvolit, kolik řádků a sloupců daný prvek obsadí, 
a následně jej pomocí myši přesunout na požadované místo v připravené tabulce 
sekce. V Properties panelu je pak možné všechny tyto prvky upravovat - měnit jeho 
umístění v tabulce, jeho rozměry, název, zarovnání a odsazení textu, apod. Tabulka 
sekce s vloženými atributy je na obrázku 3.8. 
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• 
|50 jlOD |150 |200 250 300 |35D |4O0 |450 |500 |550 |KO Ě5D |700 |750 |BO0 

rt; b IJ iJ . i. r IJ u II-
lau luci iiniLaLiui 1 1 luci iLinrvatc iciauia 

i State of registry / Stát zápisu dů r^Btnku ATTR VAL 231 Manufacturer/model / V^bce/T^a/Sarie ATTR VAL 21 

S3 Z -ireraft registrar.:- Poznáva-;' značka ATTR VAL 244 
capaje? : Call sign / Voláci znak ATTR VAL 54 

•:: z Serial number Árobn' •; 'slo letadla 
ca>nx&._ixi2 

ATTR VAL 254 

] 

150 J 150 J 
j-uiuidiL ijLjciauui 1 i r iuvu iuva i 11 icLauid 

] Operation type Druh provozu ATTR_VAL_214 I Schedule type / Druh letu 
CQ/fmai_i>K 

ATTR VAL 637 
CQ/fTFtai_C£Q 

\ 
2K' Z Operator i Provozovatel ATTR_VAL_215 Operator type .' Druh provozovatele 

CGK7*1íJí_i>Íš 
ATTR VAL 21S 

\ 
KO Z 

Aircraft Description / Popis letadla 

IŽZ z -ircraft category Kategorie letadla ATTR VAL 32 Mass z:.\:- Hmotnostn'skupina ATTR VAL 319 

Maximumt/o mass / Maximálni vzletová 
hmotnost 

Äm_VAL_175 kg 

-:: z 

Maximumt/o mass / Maximálni vzletová 
hmotnost 

] PiDDLilsion ť.-pe T-p pohonu ATTR VAL 232 nroraft damage Poškozen letadla ATTR VAL 635 

-i: Z Number of engine? Počet motoru ATTR VAL 209 

Dangerous Goods / Nebezpečné zboži 

K í Z Dang goods involved / Nebezpečné 
zboži - podii 

ATTR VAL 129 Dangerous good Nebezpečné zboži ATTR_VAL_6S8 

] 

Dang goods involved / Nebezpečné 
zboži - podii 

5K~I 
V 

Obr. 3.8: Tabulka sekce s vloženými atributy 

Sekci si lze prohlédnout pomocí File > Section Preview. Otevře se nové okno, kde 
je sekce zobrazena tak, jak bude vypadat v ECCAIRS Browseru, viz obrázek 3.9. 
Section Preview umožňuje generovat data sekce, tedy automaticky vyplnit hodnoty 
atributů náhodným textem, a také změnit barvy různých částí sekce (pozadí, text, 
okraje). Je možné si vyzkoušet i vlastní vyplňování hodnot atributů. [14] 

aerh 

File View Help 

A I R C R A F T - R E L A T E D D A T A FIELDS / DATOVÁ POLE TÝKAJÍCÍ S E L E T A D L A 
Aircraft Identification / Identifikace letadla 

State of registry / Stát zápisu do rejstříku |̂  

Aircraft registration / Poznávací značka 

Call sign / Volací znak 

Serial number / Výrobní c islo letadla 

Aircraft Operation / Provozováni letadla 

Operation type / Druh provozu 

Operator / Provozovatel 

Aircraft Description / Popis letadla 

Aircraft category / Kategorie letadla 

Propulsion type / Typ pohonu 

Number of engines / Počet motorů 

Dangerous Goods / Nebezpečné zboží 

Dang goods involved / Nebezpečně 
- podil 

|T| Manufacturer/model / Výrobce/Typ/Série 

Schedule type / Druh letu 

Operatortype / Druh provozovatele 

Mass group / Hmotnostn i skupina 

Maximumt.-o mass Maziinálni vzletová 
hmotnost 

Aircraft damage / Poškozeni letadla 

Dangerous good / Nebezpečné zboži 

Obr. 3.9: Section Preview 
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3.2.2 View Designer 

Nástroj View Designer je posledním článkem při vytváření vlastního uživatelského 
prostředí. S jeho pomocí lze uspořádat sekce vytvořené v Section Designéru 
do nového náhledu (View) a dále tento náhled upravovat. Mimo to je možné vytvořit 
Strom události (Topič Tree) a rozdělit zobrazení sekcí do témat. 

Vytvoření nového náhledu probíhá obdobně jako při vytváření nové sekce. Musí 
být zvolen název náhledu, číslo vydání je předvoleno na 1.0.0.0, ale je možné jej 
změnit, popis nového náhledu je nepovinné pole, zato povinné je opět vybrat soubor 
katalogu taxonomie, na kterém bude tento náhled založen. I zde je možné vložit 
editovací soubor, pokud je potřeba. 

Hlavní okno View Designéru, viz obrázek 3.10, obsahuje: 
- Topic-tree panel (Panel stromu témat) - vlevo, zobrazuje strom témat a k nim 

příslušející sekce, umožňuje vybírat, přidávat, odebírat témata a sekce 
- Propert ies panel (Panel vlastností) - vpravo, zobrazuje vlastnosti témata 

nebo sekce, která je právě označena v Topic-tree panelu 
- Menu Bar (Lišta menu) - všechny dostupné funkce View Designéru 
- Toolbar (Lišta nástrojů) - všechny dostupné funkce View Designéru 

zobrazené v ikonách 
- Layout switch tab-bar (Lišta výběru rozvržení zobrazení) - výběr rozvržení 

zobrazení 
- Status bar (Stavová lišta) - zobrazuje informace o náhledu - jeho název, 

číslo verze, katalog taxonomie, na kterém je náhled založen, a umístění 
náhledu v počítači 

Stejně jako pro sekce, tak i pro náhledy je možné zvolit různá rozvržení zobrazení 
podle zvoleného zobrazovacího média nebo módu. Pro náhledy jsou dostupná 
celkem čtyři rozvržení zobrazení: 

- Window - používané pro ECCAIRS Browser pro Windows; toto rozvržení je 
výchozí 

- Web - používané pro aplikaci WebDAS 
- Report (Zpráva) - používané pro zobrazení dat náhledu v módu pro tisk 

zprávy 
- PDF Form (Formulář PDF) - používané pro předávání dat samostatného 

hlášení události a následný import do ECCAIRS Reporting System 
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£ View : OPERATIONAL FULL 

File View Edit Tools 

i Ĺ u y o J % 
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| H OCCURRENCE_ WHEN 
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| _0 OCCURRENCE_MA!NTENANCE-REPORT 
i H REPORmS-HISWRY 
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S-J1 Narrative 
H - ^ J Note 
® - / ^ Events and factors 
ffl-igs Weather 
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S-fJ2l] Dangerous goods 
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^ n I I  

I £ II ^ I l&rTHide Section!"] 

= ECCAIRS Aviation (4.1.0.3) "r; OPERATIONAL FULL 

Properties 

G e n e r a l 

Name 

Identifier 

A p p e a r a n c e 

Icon 

Text Pattern 

Font 

B e h a v i o r 

Refresh all Sections 

T a x o n o m y 

Based on 

Eased on link to 

Max Instances 

S e c t i o n s 
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Attribute^) Only [ AV(Bi)_453 r AV[SL 

Name =Tahorna: Size=9; Bold=False; 

• 

Unlimited 

C:lprogram Files (>;86)1F.CCAI 

Obr. 3.10: Hlavní okno View Designéru 

V nově vytvořeném náhledu sestává Topič tree pouze z tématu Událost 
(Occurrence). Subtémata jsou přidávány pomocí funkce Edit > Add a Child Topič 
a toto vložené subtéma je upravitelné v Properties panelu. Lze volit název 
subtématu, jeho ikonu a také font, styl a velikost písma. Kořenové téma i každé 
subtéma mohou mít přiřazeny různé sekce, které se v ECCAIRS Browseru zobrazí 
v panelu po označení daného tématu. Subtémata je samozřejmě možné přesouvat 
v rámci Tbp/c řreevýš nebo níž, případně je úplně odstranit. 

Sekce se do View Designéru importují pomocí funkce Section Reference. Otevře 
se nové okno, kde pomocí tlačítka + vpravo můžeme vybrat požadované sekce 
ze složky v počítači a vložit je do View Designéru, viz obrázek 3.11. Po vložení sekcí 
vidíme, kolik sekcí jsme celkem vložili a základní informace o těchto sekcích, jako je 
název, číslo vydání, název entity, na které je sekce založená, atd. Pomocí dalších 
tlačítek vpravo je možné vybrané sekce odstranit, zobrazit si jejich vlastnosti nebo 
si najít jejich umístění v počítači. Funkce Extract Sections umožňuje extrahovat 
sekce a vytvořit samostatné soubory těchto sekcí (přípona .esd) například v případě, 
že by se původní soubory ztratily. 
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'j? Referencí 

SECTION REFERENCE 

SECI or NS~E Rŕ ŕ3Sŕ Based On Last Mod.Date rjcmain Fiter A 

AERODROME_CONTAMINATION 2.0.0.3 Aerodrome General (1) 31 03.2017 14 47:59 (No filler) 
AERODROME_FOREIGN-OBJECT 3.0. Ü.1 Aerodrome General (1) 31 03.2017 14 48:17 (No filter] 
AERODROMEJDENTIFICATION 2.0.0.3 Aerodrome General (1) 31 03.2017 14 08:29 (No filter] 
AE ROD R O M E_RFS 1.0.0.0 Aerodrome General (1} 31 03.2017 14 08:53 (No filler) 
AERODROME_VEHICLE5 2.0.0.3 Aerodrome General (1) 31 03.2017 14 09:64 (No filter) 
AI RCRAFT_ALT IMETERS 2.0.0.3 Aircraft (4) 31 03.2017 14 10:13 (No filler) 
AIRCRAFT_APPROACH_LANDING 3.0.0.0 Aircraft (4) 31 03.2017 14 10:36 (No filter) 
AI R CRAFT_AP P R OVAL S 1.0.0.0 Aircraft (4) 31 03.2017 14 10:54 (No filter) 
Al RCRAFT_ARF3 3.0.0.1 Aircraft (4) 31 03.2017 14 11:13 (No filler) 
AI RCRAFT_ASH_CLOUD 2.0.0.0 Aircraft (4) 31 03.2017 14 11:30 (No filter) 
Al RCRAFT_ATS 2.0.0.4 Aircraft (4) 31 03.2017 14 11:49 (No filter) 
Al R CRAFTAUTOP S V 2.0.0.3 Aircraft (4) 31 03.2017 14 12:20 (No filler) 
Al RCRAFT_B IRDSTRI KE 3.0.0.0 Aircraft (4) 31 03.2017 14 12:36 (No filter) 
Al RCRAFT_CALLOUT3 3.0.0.0 Aircraft (4) 31 03.2017 14 12:53 (No filler) 
Al RCRAFT_CH ARTS 2.0.0.3 Aircraft (4) 31 03.2017 14 13:11 (No filter) 
AJRCRAFT_CONFIGURATION 2.0.0.3 Aircraft (4) 31 03.2017 14 13:27 (No filter) 
Al RCRAFT_CONSEQUENCE3 2.0.0.3 Aircraft (4) 31 03.2017 14 13:42 (No filler) 
AIRCRAFT_DESCRIPTION 3.0.0.1 Aircraft (4) 31 03.2017 14 14:03 (No filter) 
Al RCRAFT_DEVI ATI ON 2.0.0.4 Aircraft (4) 31 03.2017 14 14:19 (No filter) 
AIRCRAFTJTJITCH 2.0.0.3 Aircraft (4) 31 03.2017 14 14:37 (No filler) 
AJRCRAFT_ENGINES 3.0.0.0 Aircraft (4) 31 03.2017 14 15:26 (No filter) 
AIRCRAFT FVATUATIfJN 2 0 0 3 Aircraft f4\ 31 03 2017 14 15 4P iNn fiHRri V 

Evtríct Sect ore... 

Obr. 3.11: Okno Section References ve View Designéru 

Pomocí funkce Edit > Manage Sections se přiřazují sekce k daným tématům. 
Opět se otevře nové okno se dvěma dílčími okny, přičemž v okně vlevo jsou vidět 
dostupné sekce, které byly dříve importovány do tohoto náhledu, viz obrázek 3.12. 
Prostřednictvím šipek uprostřed je možné vybírat z dostupných sekcí ty, které mají 
být přiřazeny danému vybranému tématu. 

Manage Sections 

Ava s b Ť Seit srs A Ssctor N?~ŕ 

EVENTS OCCURRENCEJHEADLINE 

MANAGEMENTSYSTEM OCCURREN CE_FI LI NG-IN FORM ATIO N 

OCCURRENC E_ATM-REl_ATION OCCURRENC E_VALI DATION 

O C C U RREN C E_ATTAC H M EN TS OCCU RREN CE_WHEN 

OCCURREN CE_CLASSIFl CATION OCCU RREN CE_WHERE 

OCCURREN CE_DAN G EROUS-GOO DS OCCURREN C E_SEVERITY 

OCCURRENCE_FILING-INFORMATION 
m 

OCCURRENC E_CLASSI Fl CATION 

OCCU RRENCE_H EADLIN E i i RAT_ATM 

OCCURRENCEJNJURIES OCCURREN CE_ATM-REI_ATIO N 

OCCU RREN C E J N VEŠTI G ATIO N-REPORT OCCURRENCEJNJURIES 

OCCU RRENCE_MAINTENANC E-REPO RT V 

< | 1 > 

Obr. 3.12: Okno Manage Sections ve View Designéru 

Pořadí sekcí v náhledu lze poté upravit ve vlastnostech daného tématu 
v Properties panelu pomocí šipek. 

Náhled je možné si prohlédnout prostřednictvím funkce File > Preview, obdobně 
jako v Section Designéru. Otevře se nové okno, kde se náhled zobrazí tak, jak bude 
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zobrazen v ECCAIRS Browseru, včetně Topic-tree panelu vlevo, viz obrázek 3.13. 
Při vybrání tématu jsou zobrazeny sekce, které jsou tomuto tématu přiřazeny, 
ve zvoleném pořadí. Zkušebně vyplnit hodnoty atributů lze pomocí funkce File > 
Generate complete data a v záložce View lze přepínat mezi rozvrženími zobrazení 
a také měnit barvy různých částí celého náhledu. [15] 

' OPERATIONAL FULL 

File Topics View Help 

Occurrence ' 

Reports 

^ Attachments 

H Narrative 

•S Note 

i/ Events and factors 

igs Weather 

lA, Aircraft 

•M Narrative 

• © Note 

•IB Persons on board and medic; 

•— History of flight 

Ý Air traffic services 

Configuration/Equipage/Chart 

fg* EGPWS/TAWS 

Aircraft recordings 

•f Parts information 

S*. Engines 

• i j Propellers 

• 'S Meteorology 

jC Fire 

• ® Survival 

• J . Ditch 

X Position/Wreckage/Impact 

O Bird/Wildlife strike 

Flight crew 
: C Member 

- - < § Other erew member 
1 £ Member 

! / Events 

W\ Dangerous goods * 

Occurrence status / 

Occurrence 

Detection phase 

Occurrence validation 

Validation status 

Authority occ. closure 

When 

Local date / Mistnf 

Local time / Mistni cas 

Where 

State/a rea of occ / 

Severity 

Highest damage / 

Injury level / Mfra 

Third party damage 

Classification 

Occurrence class / 

Validation date 

3 

UTC date / UTC 

UTCtime / UTC čas 

Location of 

Latitude of 

Longitude of 

Damage not to a/c 

Object damaged 

Obr. 3.13: Okno Preview ve View Designéru 
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4 NÁVRH VYUŽITÍ NÁSTROJE ECCAIRS 5 TAXONOMY 
DESIGN TOOLS 

Informace jednotlivých událostí v databázi se v ECCAIRS Browseru zobrazují 
v různých náhledech. Již bylo zmíněno, že v běžné instalaci ECCAIRS je 
zabudováno několik základních náhledů. Žádný z těchto náhledů ale neposkytuje 
možnost zobrazení všech informací o události na jedné stránce - informace jsou 
rozděleny do různých témat a uživatel je nucen projít všechna tato témata v Topic-
tree panelu, aby mohl zjistit veškeré údaje. Proto jsem v rámci této diplomové práce 
využila sady ECCAIRS 5 Taxonomy Design Tools a User Interface Design 
k vytvoření nového náhledu pro ECCAIRS Browser, který má podobu formuláře 
hlášení události ÚZPLN. 

Pro vytvoření náhledu bylo nutné i upravit taxonomii, konkrétně přeložit atributy, 
které jsou obsažené ve formuláři pro hlášení události. Ve výsledném náhledu, stejně 
jako v původním formuláři, jsou veškeré texty uvedeny anglicky i česky. Postupem 
překladu taxonomie a vytvoření nového náhledu se zabývá následující podkapitola. 

4.1 Postup překladu taxonomie a vytvoření nového náhledu 

V této podkapitole je popsán postup překladu původní taxonomie pomocí nástroje 
TaxDes Translation a následné vytvoření nového náhledu pro ECCAIRS Browser 
prostřednictvím nástrojů Section Desginer a View Designer. Grafické schéma 
posloupnosti kroků je v příloze 6 a výsledná podoba formuláře je v příloze 7 této 
práce. 

TaxDes Translation 
Podle manuálů k nástrojům TaxDes Customisation a TaxDes Translation má nástroj 
Translation pouze překládači okno a Translation Project soubor k překladu 
se generuje z nástroje Customisation. Ve skutečnosti ale generovaný Translation 
Project z nástroje Customisation není kompatibilní s nástrojem Translation. Proto je 
třeba při překladu taxonomie nástroj Customisation úplně vynechat a použít funkci 
File > Reverse Engineering v nástroji Translation. 

[£] Taxonomy Designer - Translation Tool 

File I View Windows Help 

tí 
Open Project Ctrl-0 

Close Project 

0 9 Reverse En g i n eeri n g 

• Save 

1 New Custom 20174103 1.0.2.0 cs.et.pt 

2 New Custom 20174103.etpc 

3 N ew Cu stom 2017 4103 1.0.2.0 en. et.pt 

Exit 

Obr. 4.1: Funkce Reverse Engineering v nástroji Translation 
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Tato funkce otevře okno pro vytvoření nového projektu, viz obrázek 4.2, kde je 
na výběr Taxonomy Project (Projekt taxonomie), Customisation Project (Upravovací 
projekt) a Profile Project (Profilový projekt). Aby potom bylo možné generovat nový 
soubor taxonomie, je potřeba vybrat Taxonomy Project, který se vytváří na základě 
původní taxonomie. Je pak otevřeno stejné editovací okno, jako v nástroji 
Customisation, pouze s jedinou změnou - není možné generovat Custom Dictionary 
(.cust), ale generuje se Dictionary (.diet), který pak slouží jako nový soubor 
taxonomie. 

Ěf£] Reverse Engineering 

Reverse Engineering 

® Taxonomy Project 

Taxonomy file 

O Customisation Project 

Taxonomy file 

Customisation file 

O Profile Project 

Taxonomy file 

Customisation file 

Profile file 

OK Cancel 

Obr. 4.2: Okno Reverse Engineering nástroje TaxDes Translation 

Dalším krokem je vytvoření vydání (funkce File > Make Release, viz obr. 4.3) 
a v okně vydání generovat překládači soubor pomocí funkce Translation > Generate 
Translation Project, viz obrázek 4.4. 

QL) Taxonomy Designer - Translation Tool 

File View Windows Help 

>• L \3 A 

"axonomy Project: ECCAIRS Aviation (ECCAIRS Aviation, etpm) [TAXONOMY] 

File 1 Edit View Tools 

Make Release 

Print Preview 

Generate PDF 

» Export Release To File 

Import Release From File 

Close Project 

Generation Date 

be used as part.. 

Obr. 4.3: Vytvoření nového vydání pomocí funkce Make Release 
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T a x o n o m y Re lease 1.0.0.0 

T a x o n o m y V i e w G e n e r a t e 

U+ / L a n g u a g e s : C z e c h 

Structure Value Lists Value Relatio 

••••101 O c c u r r e n c e 

B - ^ l Aerodrome General 

•£§pl Events 
£§pl Foreign Object 

HJp r a t i v e 

m 
• _ 

' ••<ff l Aircn& 
i i p l e h i c l e 

Aerodrome Weather Reports 

Q - ^ l A r Navigation Service 

£§pl A T M recording devices 

(i§p Events 

T r a n s l a t i o n 

^ G e n e r a t e T r a n s l a t i o n Pro jec t 

I m p o r t T r a n s l a t i o n Pro jec t 

R e m o v e C u r r e n t L a n g u a g e axonomies 

Group by All Attributes 

Attr.id Detailed 

ľ l 9 I Validation taxonomy name 

21 
B5 
127 

129 

14[ 
1S3 

Validation taxonomy version 

Dew point temperature 

Weather conditions 

Dangerous goods involved / I1 

Height of c loud base 

Liaht conditions / Sve te lné poi 

Obr. 4.4: Generování, resp. importování Translation Project souboru 
v otevřeném okně vydání 

Po otevření vygenerovaného Translation Project souboru (.etpt) se otevře 
překládači okno nástroje TaxDes Translation. V políčku Table type (Druh tabulky) je 
třeba vybrat Taxonomy Tables (Tabulky Taxonomie) a následně se v levém panelu 
zobrazí seznam atributů k překladu. Označení atributu zaktivuje pravý panel, 
ve kterém je možno přeložit název, popis a vysvětlení daného atributu. Pokud dojde 
k přeložení všech tří částí, objeví se v levém panelu vedle atributu malá ikona EU. 
Po dokončení překladu atributů je třeba Translation Project uložit. 

9 Translation Tool(New Custom J0174103 1.0.2.0 cs.etptj 

File Edit View 

Table Type: Taxonomy Tables Status: All 

S17 Actual sector load 
1 prodrome latitude 
2 Aerodrome longitude 
7 Aerodrome status / Status letiště 
10 Aerodrome type / Druh letiště 

Age 
479 Age 
401 Age /Vek 
353 Age of ATM license 
287 Ar temperature 
1052 Ar Waybill/ Consignment 
22 Arcraft altitude / Aktuáln i výška letadla 
32 Arcraft category / Kategorie letadla 
S35 Arcraft damage / Poškozeni letadla 
25 Arcraft fliglit level Aktuáln' letová hladina 
26 Arcraft height 
5% Arcraft lighting 
244 Arcraft registration / Poznávací značka 
291 Arcraft total time / Celková doba provozu letadla 
13 Arspace class / Tŕida vzdušného prostoru 

• 11 Název vzdušného prostoru 
15 Arspace type / Druh vzdušněho prostoru 
292 Arspeed 
35 Arworthiness čert. / Osvědčen i letové způsobilosti 
74 Altitude contours 

> 

Total count S49 DtalTraslatediC 

ID |14  

Description 

Original Airspace name 

Translation | Název vzdušněho prostoru  

Detailed Description 

Original Airspace name 

Název vzdušného prostoru 

Copy I 

Explanation 

Original The name of the airspace. 

Název vzdušného prostoru 

Copy I 

Default Language: English 

Obr. 4.5: Překládači okno TaxDes Translation 

4 4 



NÁVRH VYUŽITÍ NÁSTROJE ECCAIRS 5 T A X O N O M Y DESIGN TOOLS 

V editovacím okně nástroje TaxDes Translation s otevřeným vydáním vytvořeného 
Taxonomy Project souboru je nyní možné importovat překlad taxonomie pomocí 
funkce Translation > Import Translation Project, viz obrázek 4.4. Překlad by se měl 
po chvíli zobrazit, pokud ne, stačí zavřít okno vydání a znovu jej otevřít. Zbývá pouze 
generovat nový soubor taxonomie prostřednictvím funkce Generate > Make 
Dictionary, vybrat jazyk, název souboru a jeho umístění a potvrdit. Vytvořený soubor 
má příponu .diet. 

t Taxo n o my Release 4.1.0.3 

File View 

Lang 

Generate Translation 

Make Dictionary 

Structure Value Lists Value Relations Support Tables 

[=]•• HHI Occurrence 
Ö-fifp Aerodrome General 

Events 
Foreign Object 

i-"ijfp N 
r f p Note 

- |ifp -?unwa? 
L " l f p Aircraft 

^ f i S Vehicle 
(ifp Aerodrome Weather Reports 

- (ifp Air Navigation Service 
r j fp ATM recording devices 
r-jfp Events 

Tax. Ref. 

Group by 

All Taxonomies Tax. Ref. 

Group by All Attributes 

Attr.id Detailed 

19 Validation taxonomy n; 
mn 20 Validation taxonomy vs 
mn 35 Dew point temperature 
mn 127 Weather conditions 
mn 129 Dangerous goods invo 
mn 140 Height of cloud base 
mn 163 Light conditions / Svet 

Obr. 4.6: Generování nového souboru taxonomie funkcí Make Dictionary 

Section Designer 

Nová sekce se v nástroji Section Designervytváří pomocí funkce File > New Section, 
která otevře nové okno určené ke specifikaci této sekce. Povinná pole jsou Section 
name (Název sekce), Release (Vydání), Taxonomy (Taxonomie) a Based on Entity 
(Založeno na entitě), ostatní pole jsou nepovinná. Název sekce je libovolný, číslo 
vydání je předvoleno na 1.0.0.0 a není nutné jej měnit. Jako soubor taxonomie je 
třeba vybrat soubor generovaný z TaxDes Translation s přeloženou taxonomií 
s příponou .diet. Nejjednodušší je založit sekci na Root Entity (Kořenová entita), 
protože umožňuje přístup ke všem subentitám a atributům v celé taxonomii. 

Po potvrzení úvodního okna se vytvoří nová sekce. Prostřednictvím funkce View > 
Options lze upravit základní podobu sekce - počet řádků a sloupců (obr. 4.7 A), 
rozměry buněk tabulky (obr. 4.7 B), rozměry prvků vkládaných do buněk, jejich 
odsazení a zarovnání (obr. 4.7 C) a písmo (obr. 4.7 D). 
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0£>r. 4.7: Okno funkce View > Options 

Do tabulky sekce je možné vkládat všechny druhy prvků obsažené vlevo 
v Toolbox panelu. Konkrétní prvky podle vybraného druhu jsou pak zobrazeny 
ve stejném panelu dole. Například pokud je jako druh prvku zvoleno Atribute 
Definition + Value (Popis atributu + hodnota), v dolní části Toolbox panelu se zobrazí 
všechny dostupné atributy obsažené v kořenové entitě (viz obrázek 4.8 A) 
a přetažením vybraného atributu do tabulky sekce se ve zvolené buňce objeví prvek 
s popisem atributu a v sousední buňce vpravo se objeví prvek s hodnotou tohoto 
atributu. 

Pro vložení atributů obsažených v subentitách kořenové entity do tabulky sekce je 
nutné aplikovat následující postup. Napřed je třeba vybrat jako typ prvku Entity panel 
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(Panel entity) a v dolní části Toolbox panelu pak zvolit, kolik bude panel této 
subentity zabírat řádků a sloupců v tabulce sekce, vybrat požadovanou subentitu 
a jejím přetažením vložit panel do tabulky sekce (obr. 4.8 B). Při označeném panelu 
subentity (má světle zelenou barvu, neoznačený je tyrkysový) a zvolením Attribute 
Definition + Value jako typu prvku se níže v Toolbox panelu zobrazí atributy 
obsažené v subentitě, jejíž panel je právě označen v tabulce (viz obrázek 4.9). 
Tyto atributy je možné následně přenést do tabulky sekce, ale pouze do oblasti 
panelu subentity. Pokud subentita kromě atributů obsahuje ještě další vnořené 
subentity, lze panely těchto subentit vkládat pouze do panelu jejich nadřazené 
subentity. Atribut kořenové entity nebo subentity je vždy možné vložit do jejího 
vlastního panelu nebo do panelu její vnořené subentity. 

Do sekce lze vložit i obrázek nebo vlastní text. Obrázek je nutné vybrat ze složky 
počítače, v Toolbox panelu se zobrazí i náhled obrázku (obr. 4.8 C). Text se vepisuje 
do připraveného pole (obr. 4.8 D). V obou případech pak lze daný prvek přenést 
do tabulky sekce pomocí tlačítka Drag&Drop (Táhni a pusť). 

Attrbute Def 4 Value 

™ Attröute Definition 
- - Attrbute Value 

•fe En nty Dennirj an 
H Entity List 
J£ Entity Tree 
rh Entity Paid 
• ~ Entity Selector 
LUi Entity List Selector 
* H Entity Link 

Layers PanEl 
A Free TeKt 

^Unbound Control 
Table Panel 

Image 
Specie Fields 

\ l _ lne 

c-̂ CjsTDm Control 

Attribute DcF 4 Value 
34 - Occurrence < 
D 13 - Validation taxonomy i 
•=" 20-Validation taxonomy 1 

D 35 -Dew point 
•=> 127 - Weather conditions 

129 - Dana aaods hvolvei 
HO - Height af doud base 

•=" 163 -LightDonditJons/Sv 
Mn 176 - Maximum gust 

2Ö6" - Cloud amount 
275 - Speed measured at 

•=i 297 - Air temperature 
•=" 310 - visibility 
•=" 320 - Wind direction 

321 - Wind guts 
322 - Wind speed 

> 

Toolbox 

• T J Attribute Def. -I- Value 

— Attribute Definition 

- - Attribute Value 
fel Entity Definition 
_ l Entity List 
"Entity TrEe 

!™ Entity Selector 
HIll! Entity List Selector 
* • Entity Link 
?ifLayers Panel 

A Free Text 
^1 Unbound Control 
arable Panel 
Csllmane 

Spend Fields 
\ Line 

^Custom Control 

Entity Panel 

Rows/coLmns 

E)-|§D 24 • Ooourrence 
•fjP 1 - Aerocrcrne General 

2 - AerooVcme Weather R 
3-Air Space 

fjp 4-Aircraft 
fjP 10-Air RaviaatiDnService 
rJjH 1L -DB history 
fjP 14-Events 
fjP 2L -Modifications 
\ $ 22 - Narrative 
fjP 23 -Note 

# 27 - Paten tal Factors and 
[§H 23 Przcphaton aic Cth 

Tuobcx Toolbar 

• T J Attribute Def. 4-Vabe •^Attribute Def. f Value 
— AltilDute Defliltion " A t t r i b u t ^efinticn 

"•"'Attribute Value Attribut '/aLie 
fel Entity Definition fel Entity Definition 
_ J Entity List H Entity LiEt 

"Entity Tree Entity Tree 
ED Entity Panel cb Entity Panel 
•"Entity Selsc^ir •— Entity Selector 
lIlEEntity List Selector ID-Entity ust selector 
••Entity Lint ••Entity Link 
"^Layers Panel ^ Layers Panel 
A Free Text A. Free Text 

^Unbound Control tJ^Unbaund Control 
Table Panel H Tab le Pansl 
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Obr. 4.8 Toolbox panel 

4 7 

file:///l_lne


NÁVRH VYUŽITÍ NÁSTROJE ECCAIRS 5 T A X O N O M Y DESIGN TOOLS 

• • Attribute Definition 
Attribute Value 

•fei Entity Definition 
_ J Entity List 

Entity Tree 
x v Entity Panel 
• z Entity Selector 
Hüll I- tity List Selector 
* n Entity Link 
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Ö Custom Control 
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Obr. 4.9: Atribute Definition + Value při označeném Entity panelu v tabulce sekce 

Všechny prvky v sekci (atributy, hodnoty atributů, panely entit atd.) jsou 
editovatelné v Properties panelu vpravo. Panel umožňuje měnit název prvku, 
umístění a rozměr prvku v tabulce sekce, odsazení, font, viditelnost ohraničení i text. 
Náhled sekce je pak zobrazen pomocí funkce File > Section Preview, kde je možné 
na vyzkoušení vyplnit pole hodnot atributů nebo změnit barvy sekce. Hotová sekce je 
uložena s příponou .esd. 

View Designér 
Vytvořené sekce je nyní potřeba uspořádat do náhledu. Nový náhled (New View) 
se vytváří stejně jako nová sekce, okno ke specifikaci náhledu má stejná povinná 
i nepovinná pole a postup je analogický. Sekce se do View Designéru vkládají 
prostřednictvím funkce 7bo/s > Section Reference, kde se tlačítkem + otevře nové 
okno, ve kterém je možné vybrat ze složky počítače požadované sekce. 

Je možné je vložit přímo do výchozího kořenového tématu Occurrence (Událost), 
poté bude náhled v ECCAIRS Browseru tvořit pouze samotný sled sekcí bez Topic-
tree panelu vlevo. Pokud je třeba mít v náhledu více témat, použije se funkce Edit > 
Add Child Topič, která vytvoří nové téma jako podúroveň tématu, které je označené 
při vytváření, viz obrázek 4.10. 
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í > View: FORMULÁR 
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Obr. 4.10: Funkce Add Child Topič 

Do každého tématu je možno vložit vybrané sekce. K tomu slouží funkce Edit > 
Manage Sections, kde pomocí šipek přesuneme potřebné sekce z levého okna 
do pravého. Témata lze upravit v Properties panelu vpravo (název, ikona, font, pořadí 
sekcí, apod.). Náhled s alespoň jedním nově vytvořeným tématem je v ECCAIRS 
Browseru zobrazen včetně Topic-tree panelu. 

Náhled je možné si zobrazit pomocí File > Preview, kde je možné vybírat různá 
témata a zobrazovat si tak sekce, které jsou v nich vložené, dále na vyzkoušení 
vyplnit pole hodnot atributů i měnit barvy celého náhledu. Náhled se ukládá 
s příponou .evd. 

Repository Manager 
Aby bylo možné si nově vytvořený náhled zobrazit v ECCAIRS Browseru, je potřeba 
jej vložit do Repository Manageru. 

V sekci Taxonomy v části Taxonomy je nutné vyměnit soubor taxonomie 
za soubor .diet generovaný z Tax Des Translation s přeloženou taxonomií, 
viz obrázek 4.11. 
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Obr. 4.11: Okno Repository Manageru pro vložení souboru taxonomie 

V sekci Profiles > View je pak třeba přidat pomocí funkce pravé tlačítko myši 
Add View Profile from File vytvořený náhled ze složky počítače, viz obrázek 4.12. 
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Obr. 4.12: Přidání nového náhledu FORMULÁŘ funkcí Add View Profile from File 
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Nakonec v sekci Roles je ještě potřeba přidat pomocí šipek tento náhled z levého 
okna (Available profiles) do pravého (Assigned profiles), viz obrázek 4.13. Změny je 
třeba uložit prostřednictvím funkce Repository > Save changes nebo v Toolbaru 
tlačítkem Update. 
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Obr. 4.13: Přidání nového náhledu do role 

Při otevření ECCAIRS Browseru je nyní dostupný nový náhled, viz obrázek 4.14. 
Tento náhled má podobu formuláře pro hlášení události ÚZPLN a obsahuje tedy 
všechny informace, které se do tohoto formuláře vyplňují. Je rozdělen do dvou témat 
- Formulář povinného hlášení a Formulář dobrovolného hlášení - a v plném rozsahu 
je uveden v příloze 7. 
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0 ECCAIRS 5 Browser - File: [C:VU5ers\.Sarka\Desktop\DP ECCAlRS\2014.e5f] 
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Obr. 4.14: ECCAIRS Browser s nově vytvořeným náhledem FORMULÁŘ 
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ZÁVĚR 

Cílem této diplomové práce bylo popsat možnosti modifikací systému ECCAIRS 
a také navrhnout možné modifikace pro zefektivnění práce s tímto databázovým 
systémem s využitím definovaného vývojového prostředí (Taxonomy Design Tools) 
dle uživatelských potřeb na národní úrovni. 

Práce je nejdříve věnována samotnému hlášení leteckých nehod a incidentů podle 
Nařízení Evropského parlamentu a Komise (EU) č. 376/2014, s bližším zaměřením 
na postup hlášení událostí v České republice, a dále je popisován systém ECCAIRS 
sloužící jako databázový systém hlášení nehod a incidentů v letectví i jiných 
oblastech dopravy, pro uchování informací, jejich sdílení, analýzu a vyhodnocování. 
Jsou zde rozebrány nejdůležitější nástroje systému ECCAIRS a jejich funkce. 

Systém ECCAIRS lze modifikovat pomocí sady nástrojů Taxonomy Design Tools, 
která obsahuje celkem pět nástrojů určených k úpravě a překladu taxonomie, a sady 
User Interface Design, která sestává ze dvou nástrojů umožňujících změny designu 
uživatelského prostředí. Všechny tyto nástroje jsou v práci podrobně popsány. 

Hlášení událostí uložená v databázi si lze prohlédnout pomocí nástroje ECCAIRS 
Browser (Prohlížeč), který má vestavěné náhledy pro zobrazení informací uložených 
v hlášení. Žádný tento náhled ale není schopen zobrazit všechny potřebné informace 
na jedné stránce, proto jsem pro zefektivnění práce se systémem ECCAIRS vytvořila 
nový náhled pro ECCAIRS Browser, který má podobu hlášení leteckých událostí 
Úřadu pro odborné zjišťování příčin leteckých nehod (ÚZPLN). Mimo vytvoření 
samotného náhledu bylo potřeba i přeložit část taxonomie, využila jsem tedy obou 
dostupných sad pro modifikaci systému ECCAIRS. 

Výsledkem praktické části této práce je podrobný popis postupu překladu 
taxonomie a vytvoření nového náhledu pro ECCAIRS Browser, který usnadní práci 
s informacemi v databázi na národní úrovni jak při zadávání nových hlášení, tak při 
kontrole správnosti a prohlížení dat. Soubory přeložené taxonomie a náhledu 
pro ECCAIRS Browser tvoří elektronickou přílohu práce. 
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SEZNAM POUŽITÝCH ZKRATEK A SYMBOLU 

A D R E P 

CAA 

EASA 

ECCAIRS 

E C R - E C C A I R S 

ECR-SRIS 

ICAO 

J R C 

PDF 

SIA 

TaxDes 

ÚZPLN 

XLS 

WebDAS 

The Accident/Incident Data Reporting 
Hlášení dat o nehodách/incidentech 

Civil Aviation Authority 
Úřad pro civilní letectví 

European Aviation Safety Agency 
Evropská agentura pro bezpečnost v letectví 

European Co-ordination Centre for Aviation Incident 
Reporting System 
Evropské koordinační centrum systému hlášení leteckých 
incidentů 

The European Central Repositories for occurences 
Evropský centrální archiv událostí 

The European Central Repositories for safety 
Recommendations 
Evropský centrální archiv pro bezpečnostní doporučení 

International Civil Aviation Organisation 
Mezinárodní organizace pro civilní letectví 

Joint Research Centre of the European Commission 
Sdružené výzkumné centrum Evropské komise 

Portable Document Format 
Přenosný formát dokumentů 

Safety Investigation Authorities 
Úřad pro vyšetřování leteckých nehod 

Taxonomy Designer 
nástroj pro úpravu taxonomie 

Ústav pro odborné zjišťování příčin leteckých nehod 

Excel Spreadsheet 
Sešit aplikace Excel 

Web Data Access System 
Webová aplikace pro přístup k datům 
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Příloha 1: Klasifikace událostí v civilním letectví podle Prováděcího nařízení 
Komise (EU) 2015/1018 

Příloha I - Události související s provozem letadla 
1) Letecký provoz 

a. Letová příprava 
b. Příprava letadla 
c. Vzlet a přistání 
d. Kterákoli fáze letu 
e. Jiné typy událostí 

2) Technické události 
a. Konstrukce a systémy 
b. Pohonné jednotky (včetně motorů, vrtulí a rotorů) a pomocné 

energetické jednotky (APU, Auxiliary Power Unit) 
3) Interakce s letovými navigačními službami a s uspořádáním letového provozu 
4) Nouzové stavy a jiné kritické situace 
5) Vnější prostředí a meteorologie 
6) Bezpečnost 

Příloha II - Události související s technickými podmínkami, údržbou a opravou 
letadla 

1) Výroba 
2) Konstrukce 
3) Údržba a řízení zachování letové způsobilosti 

Příloha III - Události týkající se navigačních letových služeb a zařízení 
1) Události týkající se letadel 
2) Zhoršení nebo úplný výpadek služeb nebo funkcí 
3) Jiné události 

Příloha I V - Události související s letišti a pozemními službami 

1) Řízení bezpečnosti letiště 
a. Události související s letadly a překážkami 
b. Zhoršení nebo úplný výpadek služeb nebo funkcí 
c. Jiné události 

2) Pozemní odbavování letadla 
a. Události související s letadly a letištěm 
b. Zhoršení nebo úplný výpadek služeb nebo funkcí 
c. Zvláštní události související s pozemním odbavováním 



Príloha V - Události týkající se letadel jiných než složitých motorových letadel, 
včetně kluzáků a vzdušných dopravních prostředků lehčích než vzduch 

1) Letadlo jiné než složité motorové letadlo s výjimkou kluzáků a vzdušných 
dopravních prostředků lehčích než vzduch 

a. Letový provoz 
b. Technické události 
c. Interakce s letovými navigačními službami a s uspořádáním letového 

provozu 
d. Nouzové stavy a jiné kritické situace 
e. Vnější prostředí a meteorologie 

2) Kluzáky 
a. Letový provoz 
b. Technické události 
c. Interakce s letovými navigačními službami a s řízením letového provozu 
d. Nouzové stavy a jiné kritické situace 
e. Vnější prostředí a meteorologie 

3) Vzdušné dopravní prostředky lehčí než vzduch (balony a vzducholodě) 
a. Letový provoz 
b. Technické události 
c. Interakce s letovými navigačními službami a s uspořádáním letového 

provozu 
d. Nouzové stavy a jiné kritické situace 
e. Vnější prostředí a meteorologie [9] 



Příloha 2: Základní informace uváděné v hlášení letecké události podle 
Nařízení Evropského parlamentu a Rady (EU) č. 376/2014 

SPOLEČNÁ POVINNÁ DATOVÁ POLE: 

1) Nadpis 
- Nadpis 

2) Informace o složce 
- Odpovědný subjekt 
- Číslo složky 
- Status události 

3) Kdy 
- Datum v UTC {Coordinated Universal Time, koordinovaný světový 

4) Kde 
- Stát/oblast události 
- Místo události 

5) Zařazení 
- Třída události 
- Kategorie události 

6) Popis 
- Jazyk popisu 
- Popis 

7) Události 
- Typ události 

8) Klasifikace rizika 

SPECIFICKÁ POVINNÁ DATOVÁ POLE: 

A) Datová pole týkající se letadla 
1) Identifikace letadla 

-S tá t zápisu letadla do rejstříku 
- Výrobce/typ/série 
-Výrobní číslo letadla 
- Poznávací značka letadla 
-Volací značka 

2) Provoz letadla 
- Provozovatel 
-D ruh provozu 



3) Popis letadla 
- Kategorie letadla 
- T y p pohonu 
- Hmotnostní skupina 

4) Historie letu 
- Poslední místo odletu 
- Plánované místo určení 
- Fáze letu 

5) Počasí 
-V l i v počasí 

B) Datová pole týkající se letových navigačních služeb 
1) Vztah k uspořádání letového provozu 

-V l i v uspořádání letového provozu 
-Ovlivněná služba (dopad na službu uspořádání letového 

provozu) 
2) Označení jednotky letové provozní služby 

Datová pole týkající se nedodržení minimálního odstupu /ztráty rozestupu a 
narušení letového prostoru 

1) Vzdušný prostor 
- Druh vzdušného prostoru 
-Tř ída vzdušného prostoru 
-Označení letové informační oblasti (FIR, Flight Information 

Region) I vyšší informací oblasti (UIR, Upper Information 
Region) 

C) Datová pole týkající se letiště 
1) Směrovací značka místa (značka letiště) 
2) Místo letiště 

D) Datová pole týkající se poškození letadla či zranění osoby 
1) Závažnost 

- Nejvyšší škoda 
-Mí ra zranění 

2) Zranění osob 
- Počet zranění na zemi (smrtelná, těžká, lehká) 
- Počet zranění v letadle (smrtelná, těžká, lehká) [8] 



Příloha 3: Žádost o informace z ECCAIRS Repository dostupná na portálu 
ÚZPLN 

Žádost ECCAIRS 

Žádost o poskyun uti i nrormací z databází ECCAIRS (Dle nařízení Evropského parla mentu a Hady EJ c. příloha I 

Házev společnosti (jméno fyzické osoby) Sídlo společnosti (adresa) 

ICO Za konmý zástupce -funkce Zákonný zástupce - pozice 

I 
Druh činnosti 

Telefon 

laterna schránka Datum podáni Místo podání Kategorie žadatele 

Ľ 
1. Kote gori e iad-atE Le, kter-i SE Vás týká Ivir :riloha II nařízeni Ev-jpakěho pariarrientu a Rady (EU) Č. 37B/3014T -D lilašeni uriäLasti v civilním Letíctvi, anaJtyze téchto hlišeni a 

r avf J L I Í C Í : i rjpďtjefiich. 

Požadované informace 
(požadavek uveďte co nejkonkrétněji, včetně požadovaného data, období, typu letecké techniky, činnosti, druhu událostí, anod.) 

Důvod zadosti 

Objasnite, k jakému účelu budou informace využity 

Požadovaná lhůta pro poskytnuti' informaci Informace; národní data báze 

Ne 

Informace z evropské databáze 

Ne 

Obr. 1: Žádost o informace z ECCAIRS Repository 



Příloha 4: Časová posloupnost hlášení letecké události v ČR 

Při vzniku letecké nehody nebo incidentu je nutné, aby byla příslušnou osobou 
nahlášena do 72 hodin. Osoba může událost nahlásit nejdříve své organizaci, a to do 
72 hodin, tato organizace poté musí do 72 hodin po obdržení hlášení nahlásit danou 
událost odpovědnému vnitrostátnímu orgánu (v ČR tedy ÚZPLN), nebo může osoba 
nahlásit událost přímo ÚZPLN do 72 hodin. Od přijetí hlášení o události má 
organizace dále 1 měsíc na doplňující hlášení na ÚZPLN a 3 měsíce na podání 
závěrečné zprávy o události. ÚZPLN mezitím uloží hlášení do národní databáze 
leteckých nehod a odešle hlášení do Evropské centrální databáze. Po obdržení 
závěrečné zprávy má lhůtu 2 měsíců na odeslání této zprávy do Evropské centrální 
databáze, viz obr. 2. [10] 
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národní DB 

Odesláni 
hlášení doECR 

Odeslání zprávy 
doECR 

Hlášení 
organizaci 

72 h 

Hlášení na 
ÚZPLN 

72 h 72 h 

1 měsíc 

1 měsíc. 

CASOVAOÍJA 

Závěrečná zpráva 
na ÚZPLN 

_2M_ 

3 měsjce _2M 
3 měsíce _ 

T 

Hlášení 1 Hlášení na 
organizací 1 ÚZPLN 

Tok hlášení je spuštěn: 
/ fyzickou osobou 
/ co nedříve, max. 72 h 
v" organizaci 
/ ÚZPLN 
V Vložení do národní dB 

Obr. 2 ; Časová posloupnost hlášení leteckých nehod a incidentů v ČR [10] 



Příloha 5: Formuláře povinného a dobrovolného hlášení ÚZPLN 

Formulář povinného hlášení ÚZPLN: 

y 
\ Ú Z P L N 

H l á š e n í u d á l o s t i / O c c u r r e n c e r e p o r t 

A-l. SPOLEČNÁ POVINNÁ DATOVÁ POLE /COMMON MANDATORY DATA FIELDS 

A J - O z n a m u j í c í i u b j ö k l / 
Report ing Entity 

A2. O d p o v ř d n y s u b j e k t / 
Responsible entity 

Czech Republ ic w Czech Republ ic » 

ÜL-IL- w AAII 

O p e r a t o r / C o m m a n d e r o f aircraft w 

U n k n o w n 

A3-I. Číslo z á z n a m u - oznamuj Fci s u b j e k t / 
Pile number - Report ing ent i ty 

A3- i l . Číslo z á z n a m u - ÚZPLN / 
File n u m b e r - AAl l 

j U n k n o w n CZ ACl? 

USTAV PRO ODBORNE ZJIŠŤOVANÍ PRICIN 
LETECKÝCH NEHOD 

A4. '1. : : , i,. 

u n k n o w n 

AS. UTC d a t u m / UTC date 

11.1.2017 

A6. UTC r a s / U T C U m e 

UC:ÜÜ 

A3. Stá t / ú blast udá los t i 

A7_ Mľstn l d a t u m / Local date 

11.1.2017 

AS. M í s t n í ŕ a s / Local t ime 

Europe and North At lant ic 
_ 

Czech Republ ic 

-

A10. M í s t o udá los t i f 
Location of occ 

A l l . SUtuS udá lost i / 
Occurrence status 

I Initial notif ication 

A l 2 . T ľ i d a udá lost i / 
Occurrence class 

I Not d e t e r m i n e d 

A14. Typ událost i / E ť e n t Type 

3 

~3 

A13-. Kategorie udá los t i / 
Occurrence category 

U n k n o w n 

UNK: U n k n o w n or u n d e t e r m i n e d 

A15. S t u p e ň r i z i k a / 
Risk Grade 

~3 

71 
~3 

-3 

A-2. SPOLEČNÁ PQVfNNÁ DATOVÁ POLE / COMMON MANDATORY DATA FIELDS 

A16. TĚXt p o p i s u / Narrative text A17. Jazyk popisu / Narrative language Czech 

Unknown 



B-l. DATOVÁ POLE TÝKAJÍCÍ SE LETADLA/AIRCRAFT-RELATED DATA FIELDS 

Identifikace letadlo /Aircraft identification 

B l . Stát l á p i s u der re jstř íku / 
State of real st ry 

B2. P o z n á v a d í n a č k a / 
Aircraft registration 

53. Vo lác i m a k / C a l l sign 

unknown 

Ě4. V ý r o b n í tfslo letadla / 
Aircraft serial n u m b e r 

BS. V ý r o b c e / t y p / s e r l t 
M a k e / m d l / s r s 

B7. Provozovatel / Operator 

C z e c h Republ ic 

Unknown 

ÖS. Druh provozovate le / 
Opera tor type  

j U n k n o w n 

B9_ Druh letu / Schedule type 

Unknown 71 
B16. N e b e z p e č n é z b o i í - Podii / 

Dangerous goods invo lved 

I U n k n o w n • I 

Dal*,i l e t a d l o / Ottier Aircraft Data 

B12. H m o t n o s t n í skupina / 
Mass group  

Unknir.vn ~] 

B l 3 . M a x l m á l n ľ v z l e t o v á hmotnost / 
M a x i m u m take-off mass 

N u m b e r of e n g l n e i 

SIS. P o š k o z e n í l e t a d l a / 
Aircraft dunnage 

B17. N e b e z p e č n á z b o ž í / 
Dangerous Good 

Mot d e f i n e d 

B-2. DATOVÁ POLE TÝKAJÍCÍ SE LETADLA / AIRCRAFT-RELATED DATA FIELDS 

Průběh letu / History of Flight 

BIS. Pos ledn lmis to o d l e t u / 
Last departure point 

615. P l á n o v a n é místo urcen 
P lanned dest inat ion 

Počasí/ Weather 

B26 Vl iv p o ř a s í / 
W e a t h e r relevant 

I Unknown 

B27. S v e t e l n é podminkv / 
Lieht condi t ions 

[unknown 

B21. Pravidla le tu - P o d a n á / 
Filed flight rules 

U n k n o w n 

B22. Pravidla letu - A k t u á l n í / 
Current flight rules  

I U n k n o w n ^ ] 

B23. Druh provozu - P o d a n ý / 
Fi led traffic l ype 

L n k n u w n ^ ] 
B24. Druh provozu - A k t u á l n í / 

Current traffic type 

Unkriuwn 

B25. Poloha trosek vůči s m ě r u d r á h y / 

Bearing runway head ing 

Degree(s} " H I 

B2Ô. F ü r e t č lenu posádky / 
N u m b e r of Crew 

B2y_ Pocet cestuj í 
N u m b e r of Passengers 

flrrJJri osoba /Person oT controls 

&30. Řídni o s o b a / 
Person at controls 

Unknown 3 
B31. Kategorie / Category 

Unknown T 

B32. C e l k o v á praxe / 
Experience all a /c 

JHour(s) T 

Ľ i 3 . C e l k o v á praxe na typu / 
Exper ience this a / c 

iHour(s) 

B34. V e k / A g e 

Year(s) 

B3S. P o h l a v í / G e n d e r 

Unknown 

B36. Typ licence / Ucense type 

1 Other A 
Other A 
B37. Kvalifikace / R a t i n g s 

Unknown A 
B3B. P l a t n o s t / V a l i d i t y 

1 Unknown 3 



C. DATOVÁ POLE TÝKAJÍCÍ SE LETOVÝCH NAVIGAČNÍCH SLUŽEB / DATA FIELDS RELATING TO AIR NAVIGATION SERVICES 

Vnat) * A T M - A T M relation Vzdušný prostor - Ainoace 

CI. Podil A T M / A T M contr ibut ion 
CS. Druh v z d u š n é h o prostoru / CIO. A k t u á l n i v ý í k a l e t a d l a / 

A i rspace type Aircraft alt itude 

| U n k n o w n | f , -I 

C2. VIi v n a s i u i b y A T M / 
Effect o n A T M service 

C6. TFfda ._du_neho prostoru / 
A i rspace d a s s 

Zll. Povo-le-ná v ý i k a / 
• e a r e d al t i tudc 

Nul (JUIL-I -m-IĽCJ j u n k n o w n ,1 ~ 3 

C3. O z n a č e n í s t a n o v i š t i A T S / C7 OznacenlFIR/UIR 
FIR/LMR name 

1 J 

C l i Aktu á ln í l e t o v á h 1 a J1 na / 
AI rcraft f llght 1 ev e 1 

ATS unit name 

U • 1 k 1 ľ_ ' 1 

C7 OznacenlFIR/UIR 
FIR/LMR name 

1 J 

C4. Stanovište" ŕ i z e n i / 
Centra l l ing agency 

1 j d 

CL3. P o v o l e n á eto-wá h l a d i n a / 
C leared flight IŮVĚI C4. Stanovište" ŕ i z e n i / 

Centra l l ing agency I Unknown 

| U n k n o w n ^ | 
C8. SSR m o d / SSR m o d e 

C I A Časová v z d á l e n o s t / 
Distance Intlrtie 

I Unknown _ » J 

C9. SSR k o d / S S R code CIS RA T y p / R A T y p e 

1 z 

Dali ľ i" Cent inu ŕ 

C16. AP W i n s t a l o v á n / I n s t a l l e d CIS, A - 5 M G C S I n s t a l o v á n / I n s t a l l e d 

[unknown w | U n k n o w n " 

Cl?.STCA I n s t a l o v á n / I n s t a l l e d 

JnKiĽv .T i 

C15 M S A W i n s t a l o v á n / I n s t a l l e d 

Ul ikl ILJVVI 1 ^ 

D, DATO W POLE TÝKAJÍCÍ SE i É T ŕ Š I f / AERODROME-RELATED DATA FIELDS 

Le t ř í t . / Aerodrome 

D l . S m e r o v a c í značka l e t i š t ě / 
Location Indicator 

u j . Druh l e t i š t ě / 
Ae rodrome type 

i_.rikriov.Ti 

04. Status l e t l s t e / 

1 Unknown 

D5 Z n a f e n í R W V / 

H jnv.'ijy Identifier 

Unk 

Pť•̂ 5•_?̂ ĉŕ_, / Personnel 

Dé. Kategorie- / Category 

U-ikiiu'.vi ^ 

r_>7_ Prajte / rirfperieri-ce 

|rv1ůnthCs) ^ ] 

Dbl'íii. C-ontiriue 

http://i_.rikriov.Ti


E. DATOVÁ POLE TÝKAJÍCÍ SE POŠKOZENÍ LETADLA Ů ZRANĚNÍOSOB / AfRCRAFT DANfAGEOR PERSONÁL 1NJURY-RELATED DATA FfELDS 

Zó vaznost / Severity Letadlová část / Part Aircraft 

E l . Ú r o v e ň p o š k o z e n í / 
Highest Damage 

"3 

letadki / Aircraft 

E7. Ce I ková doba p-rovoz u I etad I a / 
Aircraft total time-

II-..-. • i. - • 

ES. C e l k o v ý p a ŕ e t cyklů letadla 
Total -cydes aircraft 

E9. MI -i i..- r ita Ĺ i.- údržby / 
Mal nte nance docs. 

ElO. O s v e d č e n í let. způsob i los t i / 
AI rworth I nes i ce rt. 

Unknown 11 

Dalsi i" Continue 

E2- l . f i s lo k a p l l o l y A T A / 

A T A chapter ( lumbar 

31 
31 
31 
31 
31 

U n k n o w n 

E2-1L Číslo í á s t l / 
Part n u m b e r 

E3. Počet l e t o v ý c h hodin o d G O 
Time since overhaul 

I lour(s) 

£4 P o í e t cyklů od G O / 
Cycles since overhaul 

3J 

ES. Parat l e t o v ý c h hodin ce lkem / 
T ime since n e w 

_

Í H Ô U T U ) 

E6. P o í e t c y k l ů c e l k e m / 
Cycles since new 

Zranení osob /Injuries ľa persons 

E l l . M Ír ď 2 rane m / Injury level 

3 I U n k n o w n 

Počet zraněných v tetadie / Number of injuries on aircraft 

E12. P o č e t s m r t e l n ě z r a n ě n ý c h / 
Fatal, total 

E.13. P o o a t v á i n e z r a n ě n ý c h / 
Serious injuries-total 

E14. P o č e t lehce z r a n ě n ý c h / 
Minor injuries-total  

Počet zraněných na zemi"/ Number n/injuries on ground 

EIS. Poře-t s m r t e l n ě z r a n ě n ý c h na zemi / 

Total fata l I t iesground 

E16. Počet valné z r a n ě n ý c h na zemi / 
Total ser ious Injuries-ground 

E.17. Poŕc-t lehce z r a n e n ý c h n a z e m i / 
Total minor injur ies-ground 

F. ÚDAJE SLOUŽÍCÍ POUZE PRO KONTAKTOVÁNÍ OZNAMOVATELE / DATA SERVING ONLY FOR CONTACTING OF THE NOTIFIES* 

F I J m e n o o j n a m o v a t Ě l e / N a m e F2. T e l e f o n n í c f s l o / P h o n e N u m b e r F3. E- m a l l o v á adresa / E-mail address 

+*20 I i i 

Zpet •' home' 

. niv-,o r í n ; palčeky. tHKtou iwrľariéry Krvsry-n mimir ín -Ň 

Pro Ľ* •'s- Jio n ŕcDi-'j vtpinar.i puvi'n.nk-.H ̂ oiovvv.H po'i a o^e.-v ii-piV^r;. ^ n Ľ V 

•'nakLC orie; i i i ľo TT • .ii :e n;:n tčľhní, n-jJ; n jfcTHbiivufc'Kri v ndrcaiiin CV^II UTLh PE^O f̂-." 

O F — N 'JV\ ň;Vi 1 I Ptív.'* .vi ŕŕ mff w TO J .síran ŕb' p rc- vfaža m' a BOHASÁ? I I T̂OATŮ rwri • fómxi icr/v. 

Obr. 3: Formulář povinného hlášení ÚZPLN 



Formulář dobrovolného hlášení ÚZPLN: 

\ Ú Z P L N 

Hlášení události / Occurrence report 
-i. SPOLEČNÁ POVINNÁ DATOVÁ POLE / COMMON MANDATORY DATA FIELDS 

A l . O z n a m u j í c í subjekt j 
Report ing Entity 

A2. O d p o v r d n ý i u b j e - k l / 
Re-iporiiib-le entity 

Czech Republ ic C iec l i Republ ic T 

Ut-iu- z. AAII 

Opcra to r /Commandc- r o f aircraft w 

U n k n o w n 

A3-I. Číslo z á z n a m u - oznamuj lei s u b j e k t / 
Pile number - Report ing ent i ty 

A3-II. Číslo z á z n a m u - ÚZPLN / 
File n u m b e r - AAl l 

(unknown CZ-2017 

USTAV PRO ODBORNE ZJIŠŤOVANÍ PRJCIN 
LFTECKÝCH NEHOD 

A4. N a d p i s / Headl ine 

| u n k n o w n 

AS. UTC d a t u m / U T C date 

11.1.2017 

A6. UTC ř a s . / U T C t ime 

Lt:UU 

A 7 . Mís tn í d a t u m / Local date 

| l . 1.2Ů17 

A8. M í s t n í c a s / Local t ime 

00:00 

A9. S t á t / o b l a s t udá los t i 

Europe and North At lant ic -
Czech Republ ic 

-

A l O . Mfsto u d á l o s t i / 
Location o f oce 

A l l . i l j t j s u d á l o s t i , ' 
Occurrence status 

A14. Typ událost i / Event T y p e 

Itlal notif ication 

A l 2 . Tfŕda udá lost i / 
Occurrence class 

I Not d e t e r m i n e d 

1 
~3 

A l á . Kategorie udá los t i / 
Occurrence category 

U n k n o w n 

~3 
UNK: u n k n o w n or u n d e t e r m i n e d 

A15. S t u p e ň rizl ka / 
Risk Grade 

-3 

A-2. SPOLEČNÁ POVINNÁ DATOVÁ POLE / COMMON MANDATORY DATA FIELDS 

A l b . l es t popisu / Narrative text A17. Jazyk popisu / Narrative language Ľ : Ľ L 

Obr. 4: Formulář dobrovolného hlášení ÚZPLN 
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Příloha 7: Výsledná podoba vytvořeného náhledu pro ECCAIRS Browser 
v podobě formuláře hlášení události ÚZPLN 





' FORMULAR 

File Topics View Help 

3 Occurrence 

Formulár hlásení - povinný 

Formulár hlásení - dobrovolný 

D A T A FIELDS R E L A T E D TO AIR NAVIGATION S E R V I C E S / DATOVÁ P O L E TÝKAJlCl S E LETOVÝCH NAVIGAČNÍCH SLUŽEB • 

ATM Relation / Vztah k ATM 

ATM contribution / Podíl ATM 

Effect on ATM service / Vliv na služby 

ATS Unit name / Označen i stanoviště 

Airspace / Vzdušný prostor 

SSR mode / SSR mód 

SSR code / SSR kód 

Aircraft altitude / Aktuáln i výška letadla 

Cleared altitude / Povolená výská 

Aircraft flight level / Aktuáln i letová 

Cleared flight level / Povolená letová 

Personnel / Personál 

Category / Kategorie 

' FORMULAR 

File Topics View Help 

I Occurrence 

O F 
K% Formulář hlášení - dobrovolný 

Formulář hlášení - povinný 

A I R C R A F T D A M A G E OR P E R S O N A L I N J U R Y - R E L A T E D D A T A FIELDS / D A T O V A P O L E TYKAJÍCÍ S E POŠKOZENI L E T A D L 
Severity / Závažnost 

Highest damage / Úroveň poškozeni 

Part Aircraft / Letadlová část 

ATA chapter number / Číslo kapitoly AT) 

Aircraft / Letadlo 

Aircraft total time / Celková doba provo: 

Total cycles a/c / Celkový počet cyklů 

Injuries to Persons / Zraněn i osob 

Injury level / M ira zraněn i 

Total fatalities aircraft / Počet smrtelně 
zraněných v letadle 

Tota Í Ť - : _ Í njuii-.? aircraft Po-.-ít váži 
zraněných v letadle 

Total minor injuries-aircraft / Počet lehce 
zraněných v letadle 

D A T A S E R V I N G O N L Y F O R CONTACTII 

Name / Jméno oznamovatele 

Phone Number / Telefonn i č islo 

D A J E S L O U Z l C l P R O KONTAKTOVÁNI 
E-mail adrese / E-mailová adresa 

Obr. 6: Formulář hlášení - povinný 



Formulář hlášení - dobrovolný: 
' FQRMULAR 

File Topics View Help 

Occurrence 

Formulář hlášeni - povinný 

Formulár hlásení - dobrovolný 

Occurrence report / 
Hlášení události 

C O M M O N M A N D A T O R Y D A T A FIELDS / 3 P O L E C N A P O V I N N A D A T O V A P O L E 

Reporting entity / Oinamuj ic i subjekt 

' FORMULAR 

File Topics View Help 

I Occurrence 

• Q * Formulář hlášení - povinný 

Formulář hlášení - dobrovolný 

Narrative language /Jazyk popisu 

Narrative test / Text popisu 

Obr. 7: Formulář hlášení - dobrovolný 


